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Warning 
The 725B System described herein operates on a logic voltage of 24VDC and 
as standard 24VDC is used for the field contact supply voltage. 
  
Internal or External power supplies using higher voltage AC/DC primary 
sources and optional high voltage field contact voltages may be present.  
If this is the case please ensure the necessary precautions are taken. 
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2 30-11-07 Software Installation revised P.Cartmell D. Fishkin 
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SECTION 1 - INTRODUCTION 

General 

The RTK 725B Series alarm annunciator is used to inform the operator that a 
process has gone beyond set limits using visual and audible alarms.  
 
The Annunciator is manufactured from universal cells which can be 
assembled in an array to provide the number of rows and columns required to 
suit individual panel designs. Each cell within the annunciator is able to 
contain either:- one large, two medium or four small alarm windows and the 
window is illuminated by “plug-in” universal white LED’s assemblies providing 
a maintenance free solution, a reduction in power consumption and lower 
heat dissipation. 
 
 
Large, Medium & Small Window Sizes 
 
 

 
 

Programmable Features 

The 725B is equipped with a host of customer selectable features which can 
be accessed via a USB programming port located behind the pushbutton face 
plate. Once connected to a PC running the RTK supplied configuration 
software the user can enable or disable pre-defined functions as required. 
Selection of features is on a per channel basis with no special tools or 
programming knowledge required.  
 
The Pushbutton assembly can be used to view the dynamic state of all signal 
inputs and to set the non alarm state of each alarm to normally open or 
normally closed as detailed in later sections. 
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Glossary of Terms 

 
Cell: A single module 60mm x 60mm which can be joined to adjacent 

cells in varying heights and widths to provide the number of 
alarms required. The number of alarms available per Cell 
depends on the window size required. 

 
N/C:   A Normally Closed contact which opens in the abnormal state. 
 
N/O:  A Normally Open contact which closes in the abnormal state. 
 
EN:  Energised Relay Coil that De-Energises in the abnormal state. 
 
DE-EN:  De-Energised Relay Coil that Energises in the abnormal state. 
 
Form A: Normally Open Single Pole, Single Throw Relay (SPST) contact 

that Closes in the abnormal state.  
 
Form B: Normally Closed Single Pole, Single Throw Relay (SPST) 

contact that Opens in the abnormal state. 
 
Form C: Changeover contacts, Single Pole, Double Throw (SPDT) 

contact both poles change in the abnormal state. 
 
FCV:  Field Contact Voltage. (Wetting Voltage) 
 
Card:  Refers to individual electronic circuit boards. There are various 

types of Cards used within the 725B i.e. Alarm Cards, Relay 
Cards, Supply Cards and Communication Cards. 
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Annunciator Model Code Definition 

Code 
 
Description 
 

 Model No 
B Series 725B  
  
 Window Size 

S Small – 30 mm w x 30mm h 
M Medium – 60mm w x 30mm h  
L Large – 60mm w x 60mm h 
I Intermixed – combinations of the above as required 
  
 Cells Wide 

1 – G 
1 =    1 cell wide to 9 = 9 cells wide  
A = 10 cell wide to G = 16 cells wide 

  
 Cells High 

1 – G 
1 =   1 cell high to 9 = 9 cells high  
A = 10 cell high to G = 16 cells high 

  
 Pushbutton Module 

X Not fitted 
P Integral 

  
 Number Of Active Alarms 

0 Hundreds 
3 Tenths 
2 Units   Example shown = 32 ways 
  
 Repeat Relay Facility 

X Not fitted 
R Single repeat relay per channel 
D Dual repeat relay per channel 
C Repeat relays powered by signal voltage 
  
 Integral Power Supply 

X Not fitted 

U Universal Input Power Supply – 85 to 264VAC OR 88 to 360VDC 
D Redundant Universal Input Power Supplies - 85 to 264VAC OR 88 to 360VDC 
  
 Signal Input Type 

1 24VAC/DC or 125VAC/DC 
2 48VAC/DC or 250VAC/DC 
3 24VAC/DC or 125VAC/DC differential inputs 

4 48VAC/DC or 250VAC/DC differential inputs 
  
 Tropicalisation Coating 

X Not Required 
C Tropicalised 
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 Ground Detection 
X Not Fitted 
G Internal Ground Detection card fitted 
  
 Additional Remote Pushbutton Inputs (3 per card) 

X Not Fitted 

1 – A 
1   =   3 x additional remote pushbutton Inputs fitted to 
9   = 27 x additional remote pushbutton Inputs fitted 

 A  = 30 x additional remote pushbutton Inputs fitted to 

  
 Common Relay Cards (4 per card) 

X Not Fitted 
1 – 7 1 =   4 x additional common relays fitted to 

 7 = 28 x additional common relays fitted 
  
 Time Stamping 

X Not Fitted 
T Time stamping of alarms enabled 
  
 Synchronisation Card 

X Not Fitted 
S Sync Card fitted for use with a remote GPS or IREG B Signal 
  
 Communication Hardware 

X Not Fitted 
E Entry Level – Addressing each alarm card individually 
S Standard – RS485 and Ethernet 
A Advanced – RS485, Ethernet, Additional Serial Port and Printer Port 
D Dual Standard - RS485 and Ethernet 
R Dual Advanced - RS485, Ethernet, Additional Serial Port and Printer Port 

  
 Protocol Options 

X Not Fitted 
1 Serial Modbus  
2 Serial Modbus and Ethernet 

3 DNP3 
4 Future 
5 Future 
6 Future 
  
 Special Options 

X Not Fitted 

1 – Z Reserved for Special Options 
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Product Overview 

The 725B is a modular alarm annunciator constructed from 60mm x 60mm 
cells to form a single unit suitable for mounting in a panel cut-out. This 
modular design allows units to be constructed in vast range of heights and 
widths to suit individual panel designs and allows systems to be supplied from 
a single alarm to a maximum of 256 alarms per annunciator. 

System Front View 

 
Typical Small Window Version 
 

 
 
 

Typical Medium Window Version  
 

 
 
Typical Large Window Version    
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Number Of Alarms Per Cell 
Each 60mm x 60mm cell within the annunciator can contain 1, 2 or 4 alarms 
depending on the required window size:- 
 

Window Style Window Size (W x H) Alarms per Cell 
Large 60mm x 60mm 1 

Medium 60mm x 30mm 2 
Small 30mm x 30mm 4 

 
If requested at the time of order the unit can be supplied with intermixed 
window sizes in any combination 
 
Integral Pushbutton Location 
When viewing the front of the annunciator the bottom right hand corner is 
normally reserved for the integral pushbutton module.  
 
If advised at the time of order the following alternatives are available 
 
 

1. The integral pushbutton module can be placed in any cell within the 
annunciator. 

 
2. The integral pushbutton module can be replaced with active alarm 

channels and remote pushbuttons can be used to control the alarm 
annunciator. 

 
3. The Pushbutton assembly can be supplied as a remote assembly 

which can be interconnected with the annunciator via a factory supplied 
ribbon cable  
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Window Illumination 

Each channel is illuminated by white “Plug-In” LED’s which offer a 
maintenance free solution, lower heat dissipation and lower power 
consumption. Each LED assembly is equipped with 2 pins that allows it be 
“plugged” into the 2 pin socket in the cell behind each alarm window. 

 

CB7028-0

RTK
POLARITY 

MARKING

FRONT VIEW SIDE VIEW

725B CELL PINS

 
 
Please note the CB7028POP1 white LED assembly is factory fitted with the 
half circle in the top left hand corner as shown above.  
 
If the LED assembly is inserted while power is applied to the system the LED 
may blink when it is first inserted but will automatically return to the off state if 
no alarm is present. 
 
If it is inserted upside down, no damage will occur but the LED will not 
function.  
 
To remove the LED assembly a pair of pin-nosed pliers can be used on the 
sides of the circuit board to gently pull the assembly towards you.  
 
The number of LED’s required per window is governed by the window size.  
 

• Small window versions use a single LED assembly  
 

• Medium window versions use two LED assemblies 
 

• Large window versions use four LED assemblies 
 
LED Failure Indication 
 
The 725B is equipped with LED monitoring to provide indication of total loss of 
indication to a channel using the Watchdog, WD, LED mounted on the face of 
the Pushbutton Module or the software diagnostic facility as described later in 
the manual. As an option a common relay can be used to provide remote 
indication of LED failure if required. 
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Window Colours 

Each channel is equipped with its own removable lens assembly, which, 
contains a coloured filter and a laser printed film legend.  
 
White filters are used in standard applications but coloured filters can be used 
as an alternative to provide a clear indication of alarm type.  
 
For example Red can be used for trip alarms, amber for pre-alarms and green 
for status. A choice of Six colours are available:- White, Red, Amber, Yellow, 
Green or Blue. 
 

 
 
Adding or Changing Film Legends 
 
Each lens assembly has a small slot in the upper ridge of the surround bezel, 
which allows a flat blade terminal screwdriver to be used to gently lever the 
assembly from the annunciator.  
 
Once the assembly has been removed the lens, coloured filter and film legend 
can be accessed by gently pushing outwards on the side of the inside face of 
the bezel to allow the lens to clear the associated moulding tabs.  
 

TAHH-32A
TEMPERATURE

ALARM
HIGH-HIGH

COLOURED FILTER

FILM LEGEND
SLOT TO LEVER

THE BEZEL OUT

BEZEL

LENS
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Filter & Bezel Spare Parts Numbers 

 

Part Small Window Medium Window Large Window 

Bezel ML-7227-S ML-7227-M ML-7227-L 

Clear Lens ML-7228-S ML-7228-M ML-7228-L 

Red filter ML-7229-S-RD ML-7229-M-RD ML-7229-L-RD 

Amber filter ML-7229-S-AM ML-7229-M-AM ML-7229-L-AM 

Yellow filter ML-7229-S-YW ML-7229-M-YW ML-7229-L-YW 

Blue filter  ML-7229-S-BL ML-7229-M-BL ML-7229-L-BL 

Green filter  ML-7229-S-GN ML-7229-M-GN ML-7229-L-GN 

Laser Printed Legends 

Film legends can be easily created in a style, size, font and language using 
Microsoft Excel or the RTK supplied configuration software.  
 
Once the legend details have been entered they can be laser printed onto 
overhead transparency film and placed between the clear front lens of the 
window assembly and the associated coloured filter as shown above. 
                                                                                                                                                                                              

Window Numbering System 

RTK have adopted the following window numbering system to aid with the 
location of the film legend and the associated alarm cards.  
 
This method is used to ensure that the legend matches the functions selected 
for the designated alarm. 

2

1 5

6

4

3
RESETMUTE

SYST
TEST

FIRST

RESET

LAMP
TEST

ACK ACK

FIRST

RESET
SYST
TEST

MUTE

LAMP
TEST

RESET

FIRST

RESET

3

2

1

SYST
TEST

LAMP
TEST

MUTE

ACK

RESET

1 2

43

5 6

87

9 10

11 12

Large Window Version Medium Window Version Small Window Version

WD

COM

PWR

FC WD

COM

PWR

FC WD

COM

PWR

FC
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Integral Pushbutton Module 
On standard systems the pushbutton / programming module is located in the 
bottom right hand corner of the annunciator when viewed from the front.  
 
If advised at time of order the pushbutton module can be located in any 
alternative cell within the annunciator.  
 

 
 
Pushbuttons 
Six Pushbuttons:- Lamp Test, Systems Test,  Mute,  Ack, Reset and First 
Reset, are available to allow the user to control any of the customer 
selectable ISA sequences.  
 
Some users prefer to lock out specific pushbutton functions and any of the 
integral pushbuttons can be disabled in software.  
 
A typical example is first reset where the user prefers to use a remote key 
switch to reset the first up indication in place of the integral pushbutton. 

Watchdog Monitoring LED’s 

As alarm annunciators are used in safety critical applications it is important 
that that the functions of the annunciator are also monitored and the 725B is 
equipped with an extensive self diagnostic facility and four green status LED 
bars are used to provide dynamic monitoring of logic power, field contact 
supply, watchdog and communications states.  
 
The LED’s indicate  
 

1. PWR   = 24VDC logic power to individual cards 
2. FC       = Field contact power & contact loop resistance monitoring 
3. COM    = Communications 
4. WD      = Watchdog monitoring of individual cards 

  
When power is initially applied to the unit the four green LED bars illuminate in 
a rotational sequence whilst the system verifies that all of the expected cards 
are present and once the start up routine is complete the LED’s stay ON if all 
functions are fully operational. 
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USB Programming port 

A small flat blade screwdriver can be used to gently ease the top edge of the 
pushbutton face plate out which allows access the USB programming port 
which can be used to:- 
 

1. Upload a configuration from an existing 725B 
2. Download a configuration to the 725B 
3. View diagnostic data whilst fault finding.  

 
 

 
 
 
 
 
Once the user connects the supplied cable between a PC and the USB 
programming port the four green LED bars on the front of the pushbutton 
module will flash in unison to indicate that the port is being used. 
 
Tx and Rx Status LED’s are provided to indicate any communication activity 
between the 725B and host PC. 
 
 Full details of programming are provided in later sections of this manual.                                                            

USB Port 

Rx Status LED Tx Status LED 
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CAL Mode  

The 725B unit can be placed into CAL mode which allows the user to view the 
dynamic status of the associated plant inputs or the user can use the 
pushbutton module to set the non alarm state of each alarm (N/O or N/C). 

 

 
 
 
To place the unit into CAL mode the CAL switch needs to be pushed down in 
the direction of the arrow as indicated above.  
 
Whilst in CAL mode the PWR / COM LED bars flash followed by the WD / FC 
LED bars and this sequence cycles until the cal switch is turned off.  
 
Please note whilst in CAL mode the pushbuttons have alternative functions 
and the CAL switch must be in the OFF mode for the normal pushbutton 
functions to operate correctly.  
 
If an alarm occurs whilst in CAL mode the audible will sound and once the 
user places the switch back to normal the alarm will be displayed in the 
normal way. 

Signal Input Contact Status 

During commissioning or fault finding the user can easily determine the 
current status of all of the plant inputs connected to the alarm annunciator by 
placing the unit into CAL mode. 
 
Once in this mode each window on the 725B indicates the dynamic status of 
the associated plant input. 
 

• If the alarm window is OFF the associated plant input is OPEN 
 

• If the alarm window is ON the associated plant input is CLOSED 
 
Please note: The OPEN and CLOSED indication refers to the customer’s field 
contact and is not related to the non alarm state set in the annunciator. (N/O 
or N/C) 

 Push Down For CAL Mode 

 



Series 725B Instruction Manual – Rev 5 
 

Page 19 of 169 

Configuring Alarm Inputs for use with N/O or N/C field contacts 

The non alarm state of each alarm channel can be configured in software to 
allow the channel to operate from either a N/O or N/C contact as described 
later in this manual.  
 
As an alternative the integral pushbutton module can be used to set this 
function by sliding the CAL switch down to the ON position.  
 
When in CAL mode the function of the integral pushbuttons changes to allow 
the user to navigate between channels, select the function and set the 
function as detailed below. 
 
Pushbutton Abbreviation Function in CAL Mode 
Lamp Test CHDN Channel Down      
Ack FDN Function Down 
Mute SET Set 
Reset SET Set  
System Test CHUP Channel Up 
First Reset FUP Function Up 

 
The alternative function of each pushbutton is indicated on the inside face of 
the pushbutton assembly but it is the pushbutton on the front of the assembly 
that is used to physically activate the function. 
 

 
 
 
 
Function Up / Down 
The integral pushbutton module has two functions.  
 

1. It can be used to dynamically view the status of all signal inputs to 
determine which inputs are open or closed. 

 
2. It can be used to set the non alarm state of each alarm channel to N/O 

or N/C. 
 

Channel Down  

Channel Up  Function Up  

Function Down 

Set  Set  
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When the unit is first switched to CAL mode it defaults to the contact 
monitoring state. If the user wishes to change the non alarm contact state of 
any inputs the Function Up (First Reset Pushbutton) must be pressed.  
 
Once the Function Up has been selected the top left hand window flashes to 
indicate that the 1st channel is in programming mode and the user can set of 
navigate to each channel as required. 
 
Channel Up / Down 
The user is able to navigate to the required channel by pressing the System 
Test (channel up) to navigate to channel 1 to 2 to 3 etc and Lamp Test 
Pushbutton (channel down) to navigate from channel 3 to 2 to 1 etc. 
 
Setting the Non Alarm Input State 
Once the user has navigated to the required channel each time the Mute, or 
Reset, pushbutton is pressed the input state is inverted from N/O to N/C.  
 

• If the status LED is OFF the channel is suitable for use with N/O 
contacts. 

 

• If the status LED is ON the channel is suitable for use with N/C 
contacts. 

 
CAUTION:- This information is only saved when the user navigates to another 
channel (up or down).  If the user places the CAL switch to the OFF position 
without navigating to an adjacent channel the information will not be stored. 
 
Remote Pushbutton Module 
As an alternative the 725B can be fully equipped with alarm windows and the 
Pushbutton Module can be supplied as a remote item or the user can use 
conventional panel mounting momentary, N/O, pushbuttons to control the 
annunciator. 
 
In these applications the common watchdog / relay, WR, card part no 
CB6641POP2 is equipped with a USB programming port which is located on 
the underside of the associated cell. Full details are provided in section 2 of 
this manual  

Audible Alarms 

Two internal audible alarms are provided as standard behind the pushbutton 
module for use as critical and non critical audibles.  
 
As standard the audibles provide a steady tone but each horn can be software 
selected to pulse if required. The volume of each horn is selectable in 
software from 0 to 100% of span and a test volume feature is provided as 
described later in the manual. Please note if the pulse option has been 
selected the software “test volume” function overrides the pulse feature to 
make adjustment simpler.  
 
Each channel can be set in software to activate either of the integral horns. 
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SECTION 2 – CELL TYPES 
 

Each 725B alarm annunciator is constructed from modular building blocks, 
“CELLS”. The type of card installed within each cell is dependent on the 
options required.  
 
The following pages detail the individual cell types, available options and each 
annunciator can be manufactured using combinations of cells and types to 
suit individual panel designs. 
 
A Cell Detail (Alarm Cell) 
 

A

INPUTS

1 2 3 4 3C2C1C 4C

CHANNEL

CUSTOMERS 

VOLT FREE 
INPUTS

CELL 1 - REAR VIEW

5 - 8

ALARM CARD VERSIONS USED IN "A" CELLS 

(LOWER SLOT)

CB6611POP1    - 24/125V SIGNAL INPUT VERSION

CB6611POP5    - 24/125V SIGNAL INPUT VERSION 

                             PLUS TIME STAMPING OPTION

CB6611POP2    - 48/250V SIGNAL INPUT VERSION

CB6611POP6    - 48/250V SIGNAL INPUT VERSION 

                             PLUS TIME STAMPING OPTION

 

Cell type A is used to provide:- 
 

• Four digital inputs for use with volt-free or powered contacts  
 

• The drawing above indicates the standard card types available for cell 
type A 
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A Cell - Differential Input Version 

 

A

INPUTS

1 2 3 4 3C2C1C 4C

CHANNEL

CUSTOMER 

INPUTS

CELL 1 - REAR VIEW

5 - 8

ALARM CARD VERSIONS USED IN "A" CELLS 

(LOWER SLOT)

CB6611POP9    - 24/125V DIFFERENTIAL INPUT VERSION

CB6611POP11  - 24/125V DIFFERENTIAL INPUT VERSION 

                             PLUS TIME STAMPING OPTION

CB6611POP10  - 48/250V DIFFERENTIAL INPUT VERSION

CB6611POP12  - 48/250V DIFFERENTIAL INPUT VERSION 

                             PLUS TIME STAMPING OPTION

 

Cell type A is used to provide:- 
 

• Four isolated digital inputs for use with volt-free or powered contacts  
 

• The drawing above indicates the OPTIONAL differential input version 
where each channel is provided with a fully isolated bi-polar input. 
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AR Cell Detail (Alarm – Relay Cell) 
 

AR

INPUTS

1 2 3 4 3C2C1C 4C

CHANNEL

CUSTOMERS 
VOLT FREE 

INPUTS

CELL 1 - REAR VIEW

5 - 8

R3 R4R2R1

RELAY OUTPUTS

ALARM CARD VERSIONS USED IN "AR" CELLS 
(LOWER SLOT)

CB6613POP1 (4) CHANNEL RELAY CARD

RELAY CARD VERSION USED IN "AR" CELLS 

(UPPER SLOT)

CB6611POP1   - 24/125V SIGNAL INPUT VERSION

CB6611POP5   - 24/125V SIGNAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

CB6611POP2   - 48/250V SIGNAL INPUT VERSION

CB6611POP6   - 48/250V SIGNAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

 

Cell type AR is used to provide:- 
 

• Four digital inputs for use with volt-free or powered contacts  
 

• Four repeat relays providing volt-free contact outputs for use with third 
party devices  

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The coil state can be programmed to be either EN or DE-EN per relay  
 
The drawing above indicates the standard card types available for cell type 
AR  
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AR Cell - Differential Input Version 

 

AR

INPUTS

1 2 3 4 3C2C1C 4C

CHANNEL

CUSTOMER

INPUTS

CELL 1 - REAR VIEW

5 - 8

R3 R4R2R1

RELAY OUTPUTS

ALARM CARD VERSIONS USED IN "AR" CELLS 

(LOWER SLOT)

CB6613POP1 (4) CHANNEL RELAY CARD

RELAY CARD VERSION USED IN "AR" CELLS 

(UPPER SLOT)

CB6611POP9   - 24/125V DIFFERNTIAL INPUT VERSION

CB6611POP11 - 24/125V DIFFERENTIAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

CB6611POP10 - 48/250V DIFFERENTIAL INPUT VERSION

CB6611POP12 - 48/250V DIFFERENTIAL INPUT VERSION  
                            PLUS TIME STAMPING OPTION

 

Cell type AR is used to provide:- 
 

• Four isolated digital inputs for use with volt-free or powered contacts  
 

• Four repeat relays providing volt-free contact outputs for use with third 
party devices  

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The coil state can be programmed to be either EN or DE-EN per relay  
 

• The drawing above indicates the OPTIONAL differential input version 
where each channel is provided with a fully isolated bi-polar input. 
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AP Cell Detail (Alarm – Pushbutton Cell) 
 

AP

INPUTS

1 2 3 4 P2P1C P3

CHANNEL

CUSTOMERS 

VOLT FREE 

INPUTS

CELL 0 - REAR VIEW

1 - 4

EXTERNAL

PUSHBUTTON

INPUTS

CB6611POP3 - 24/125V SIGNAL INPUT VERSION

                         PLUS 3 x PUSHBUTTON INPUTS

CB6611POP7 - 24/125V SIGNAL INPUT VERSION 

                         PLUS 3 x PUSHBUTTON INPUTS

                         AND TIME STAMPING OPTION

CB6611POP4 - 48/250V SIGNAL INPUT VERSION

                          PLUS 3 x PUSHBUTTON INPUTS

CB6611POP8 - 48/250V SIGNAL INPUT VERSION 

                         PLUS 3 x PUSHBUTTON INPUTS

                         AND TIME STAMPING OPTION

ALARM CARD VERSIONS USED IN "AP" CELLS 

(LOWER SLOT)

+V

 
 

Cell type AP is used to provide:- 
 

• Four digital inputs for use with volt-free or powered contacts  
 

• Three external pushbutton inputs for use with optional remote 
mounting pushbuttons as required. 

 

• Each of the external pushbutton inputs can be programmed to operate 
as either:- Lamp Test, Silence, Acknowledge, Reset, 1st Reset or 
System Test or Sleep Mode as required. The common return for all 
remote pushbuttons is +V (+24VDC) 

 

• The drawing above indicates the standard card types available for cell 
type AP.  

 

• Multiple AP cells may be used in applications that require more than 3 
x pushbutton inputs or in systems using multiple pushbutton groups to 
control selective channels  
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APR Cell Detail (Alarm / Pushbutton – Relay Cell) 
 

APR

INPUTS

1 2 3 4 P2P1C P3

CHANNEL

CUSTOMERS 

VOLT FREE 
INPUTS

CELL 0 - REAR VIEW

1 - 4

RELAY OUTPUTS

R1 R2 R4R3

RELAY CARD VERSION USED IN "APR" CELLS 
(UPPER SLOT)

CB6613POP1 (4) CHANNEL RELAY CARD

ALARM CARD VERSIONS USED IN "APR" CELLS 
(LOWER SLOT)

CB6611POP3 - 24/125V SIGNAL INPUT VERSION

                         PLUS 3 x PUSHBUTTON INPUTS

CB6611POP7 - 24/125V SIGNAL INPUT VERSION 
                         PLUS 3 x PUSHBUTTON INPUTS 

                         AND TIME STAMPING OPTION

CB6611POP4 - 48/250V SIGNAL INPUT VERSION

                          PLUS 3 x PUSHBUTTON INPUTS

CB6611POP8 - 48/250V SIGNAL INPUT VERSION 

                         PLUS 3 x PUSHBUTTON INPUTS
                         AND TIME STAMPING OPTION

+V

EXTERNAL
PUSHBUTTON

INPUTS

 
 

Cell type APR is used to provide:- 
 

• Four digital inputs for use with volt-free or powered contacts  
 

• Three external pushbutton inputs for use with optional remote 
mounting pushbuttons as required. 

 

• Each of the external pushbutton inputs can be programmed to operate 
as either:- Lamp Test, Silence, Acknowledge, Reset, 1st Reset or 
System Test or Sleep Mode as required. The common return for all 
remote pushbuttons is +V (+24VDC) 

 

• Four repeat relays providing volt-free contact outputs for use with third 
party devices  

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The coil state can be programmed to be either EN or DE-EN per relay  
 

• The drawing above indicates the standard card types available for cell 
type APR. 

 

• Multiple APR cells may be used in applications that require more than 
3 x pushbutton inputs or in systems using multiple pushbutton groups 
to control selective channels. 
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AWR Cell Detail (Alarm – Watchdog Relay Cell) 
 

AWR*

INPUTS

1 2 3 4 3C2C1C 4C

CHANNEL

CUSTOMERS 

VOLT FREE 

INPUTS

CELL 1 - REAR VIEW

5 - 8

CR1

RELAY OUTPUTS

CB6611POP1   - 24/125V SIGNAL INPUT VERSION

CB6611POP5   - 24/125V SIGNAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

CB6611POP2   - 48/250V SIGNAL INPUT VERSION

CB6611POP6   - 48/250V SIGNAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

(LOWER SLOT)

RELAY CARD VERSION USED IN "AWR" CELLS 

(UPPER SLOT)

CR2 CR4CR3
CB6641POP1 (4) CHANNEL RELAY CARD

 

Cell type AWR* is used to provide:- 
 

• Four digital inputs for use with volt-free or powered contacts  
 

• Four Common Relays which can be programmed for use as horn, 
common alarm or diagnostic watchdog relays 

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The non alarm coil state of each relay can be programmed to be either 
EN or DE-EN  

 

• * = AWR Card i.e. AWR1, AWR2, etc the suffix number is used in 
systems using multiple AWR Cells to aid programming / wiring. 

 
The drawing above indicates the standard card types available for cell type 
AWR  
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AS Cell Detail (Alarm – Supply Cell) 
 

CUSTOMERS 
VOLT FREE 

INPUTS

AS

2C

5 - 8

CHANNEL

1 2 3

INPUTS

4 1C 3C 4C

LN

CELL 1 - REAR VIEW

PSU 
POWER CARD VERSION USED IN "AS" CELLS 
(UPPER SLOT)

CB6617POP1 POWER CARD 85-264VAC or 88-360VDC

ALARM CARD VERSIONS USED IN "AS" CELLS 
(LOWER SLOT)

CB6611POP1   - 24/125V SIGNAL INPUT VERSION

CB6611POP5   - 24/125V SIGNAL INPUT VERSION  
                            PLUS TIME STAMPING OPTION

CB6611POP2   - 48/250V SIGNAL INPUT VERSION

CB6611POP6   - 48/250V SIGNAL INPUT VERSION  
                            PLUS TIME STAMPING OPTION

2A / T

  
Cell type AS is used to provide:- 
 

• Four digital inputs for use with volt-free or powered contacts  
 

• Universal Input Power Supply capable of accepting either:- 
 

• AC voltages in the range 85-264VAC or  
 

• DC voltages in the range 88-360VDC 
 

• The Power Supply card is located in the upper card slot as typically 
shown above. 

 

• The power supply is suitable for use with a number of cells which 
varies depending on the window size used and the options fitted. 

 

• Multiple power supply cards can be used in larger annunciators. 
 

• The drawing above indicates the standard card types available for cell 
type AS 
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AS Cell - Differential Input Version 
 

CUSTOMER

INPUTS

AS

2C

5 - 8

CHANNEL

1 2 3

INPUTS

4 1C 3C 4C

LN

CELL 1 - REAR VIEW

PSU 
POWER CARD VERSION USED IN "AS" CELLS 

(UPPER SLOT)

CB6617POP1 POWER CARD 85-264VAC or 88-360VDC

ALARM CARD VERSIONS USED IN "AS" CELLS 

(LOWER SLOT)

CB6611POP9   - 24/125V DIFFERENTIAL INPUT VERSION

CB6611POP11 - 24/125V DIFFERENTIAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

CB6611POP10 - 48/250V DIFFERENTIAL INPUT VERSION

CB6611POP12 - 48/250V DIFFERENTIAL INPUT VERSION  

                            PLUS TIME STAMPING OPTION

2A / T

  
Cell type AS is used to provide:- 
 

• Four Isolated digital inputs for use with volt-free or powered contacts  
 

• Universal Input Power Supply capable of accepting either:- 
 

• AC voltages in the range 85-264VAC or  
 

• DC voltages in the range 88-360VDC 
 

• The Power Supply card is located in the upper card slot as typically 
shown above. 

 

• The power supply is suitable for use with a number of cells which 
varies depending on the window size used and the options fitted. 

 

• Multiple power supply cards can be used in larger annunciators. 
 

• The drawing above indicates the standard card types available for cell 
type AS 

 

• Fuse FU-2A-004 5 x 20 mm 2A Fuse is used to protect the primary 
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S Cell Detail (Supply Cell) 
 

S

LN

REAR VIEW

PSU 
POWER CARD VERSION USED IN "S" CELLS

(UPPER SLOT)

CB6617POP1 POWER CARD 85-264VAC or 88-360VDC

2A / T

Cell type S is used to provide:- 
 

• Universal Input Power Supply capable of accepting either:- 
 

• AC voltages in the range 85-264VAC or  
 

• DC voltages in the range 88-360VDC 
 

• The Power Supply card is located in the upper card slot as typically 
shown above. 

 

• The power supply is suitable for use with a number of cells which 
varies depending on the window size used and the options fitted. 

 

• Multiple power supply cards can be used in larger annunciators. 
 

• Fuse FU-2A-004 5 x 20 mm 2A Fuse is used to protect the primary 
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SS Cell Detail 

 (Supply - Supply Cell) 
 
 

SS

LN

REAR VIEW

PSU 
POWER CARD VERSION USED IN "SS" CELLS

(UPPER SLOT)

CB6617POP1 POWER CARD 85-264VAC or 88-360VDC

PSU 

N L
CB6617POP1 POWER CARD 85-264VAC or 88-360VDC

POWER CARD VERSION USED IN "SS" CELLS

(LOWER SLOT)

2A / T

2A / T

 
Cell type SS is used to provide:- 

 

• Dual Universal Input Power Supply each capable of accepting either 
 

• AC voltages in the range 85-264VAC or  
 

• DC voltages in the range 88-360VDC 
 

• The Power Supply cards are located in the upper and lower card slot 
of the cell as typically shown above. 

 

• The dual power supply is suitable for use with a number of cells which 
varies depending on the window size and the options required. 

 

• Multiple power supply cards can be used in larger annunciators as 
required. 

 

• Fuse FU-2A-004 5 x 20 mm 2A Fuse is used to protect the primary 
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WR Cell Detail (Watchdog - Relay Cell) 
 

WR

RELAY OUTPUTS

CR1

REAR VIEW

CB6641POP1   - WATCHDOG / RELAY CARD

RELAY CARD VERSION USED IN "WR" CELLS

(LOWER SLOT)

CR2 CR3 CR4

 
Cell type WR is used to provide:- 
 
WR cells are equipped with a four channel relay card which provide 
 

• Four Common Relays which can be programmed for use as horn, 
common alarm or diagnostic watchdog relays 

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The non alarm coil state of each relay can be programmed to be either 
EN or DE-EN.   
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WRS Cell Detail (Watchdog / Relay - Supply Cell) 
 

WRS

RELAY OUTPUTS

CR1

REAR VIEW

CB6641POP1   - WATCHDOG / RELAY CARD

RELAY CARD VERSION USED IN "WRS" CELLS

(LOWER SLOT)

CR2 CR3 CR4

CB6617POP1 POWER CARD 85-264VAC or 88-360VDC

POWER CARD VERSION USED IN "WRS" CELLS 

(UPPER SLOT)PSU 

N L
2A / T

 
Cell type WRS is used to provide:- 
 
WR cells are equipped with a four channel relay card which provide 
 

• Four Common Relays which can be programmed for use as horn, 
common alarm or watchdog relays 

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The non alarm coil state of each relays can be programmed to be 
either EN or DE-EN  

 

• Universal Input Power Supply capable of accepting:- 
 

• AC voltages in the range 85-264VAC or  
 

• DC voltages in the range 88-360VDC 
 

• The Power Supply card is located in the upper card slot and the 
common relay card is located in the lower card slot as typically shown 
above. 

 

• The power supply is suitable for use with a number of cells which 
varies depending on the window size and options required 

 

• Multiple power supply cards can be used in larger annunciators as 
required. 

 

• Fuse FU-2A-004 5 x 20 mm 2A Fuse is used to protect the primary 
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WRR Cell Detail (Watchdog / Relay - Relay Cell) 
 

WRR

CR1

REAR VIEW

CB6641POP1   - WATCHDOG / RELAY CARD

RELAY CARD VERSION USED IN "WRR" CELLS 
(LOWER SLOT)

CR2 CR3 CR4

RELAY CARD VERSION USED IN "WRR" CELLS 
(UPPER SLOT)

CB6613POP1   - (4) CHANNEL RELAY CARD

CR5 CR6 CR7 CR8

RELAY OUTPUTS

RELAY OUTPUTS

 
Cell type WRR is used to provide:- 
 
WRR cells are equipped with two four channel relay cards which provide 
 

• Eight Common Relays which can be programmed for use as horn, 
common alarm or diagnostic watchdog relays 

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The non alarm coil state of each relay can be programmed to be either 
EN or DE-EN 
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Optional WR Cell Detail (Watchdog - Relay Cell) used on systems not 
equipped with integral Pushbutton / Programming Modules 
 

WR

RELAY OUTPUTS

CR1

REAR VIEW

RELAY CARD VERSION USED IN "WR" CELLS
(LOWER SLOT)

CR2 CR3 CR4

CB6641POP2   - WATCHDOG / RELAY CARD

FOR USE WITH SYSTEMS NOT EQUIPPED

WITH INTEGARL PUSHBUTTONS

 
This version of Cell type WR is used on systems that are not equipped with 
the integral pushbutton / programming module. 
 
This version of the WR cell is equipped with a four channel relay card plus a 
USB programming port which provide 
 

• Four Common Relays which can be programmed for use as horn, 
common alarm or diagnostic watchdog relays 

 

• Each of the output contacts can be set to N/C or N/O using a 3 way 
header and 2 way shorting bar located on the card. 

 

• The non alarm coil state of each relay can be programmed to be either 
EN or DE-EN.   

 

• USB Programming port which is located on the underside of the 
associated cell to allow the unit to be programmed. 
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USB Programming Port Location 
 
Error! Objects cannot be created from editing field codes. 
The USB port has TX and RX Status LED’s to monitor communication activity. 
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SECTION 3 – LOGIC SUPPLY & FUSING 

 
All 725B Alarm Annunciators operate from a 24VDC logic supply.  

Externally Powered Systems 

When external power supplies are used 24VDC must be connected to 
terminals OV and +V as shown below.  
 
Fuse F1, (5 x 20mm 8A), is provided on the underside of the power input card 
to protect the alarm logic and +24VDC is internally linked to all of the 
associated cards within the system.  
 
Red LED F1 is used to indicate that the +V fuse has blown. 
 

REAR VIEW

OV OV +V+V 0VC +VC

Rx F1 F2 Tx

 FROM EXTERNAL

24VDC SUPPLY

(+)

(OV)
UNDERSIDE VIEW OF

POWER INPUT CARD

F1
8A

F2
1A

LOGIC 
FUSE

8A

SIGNAL
FUSE

1A

 
Fuses  
FU-1A-002 - 5 x 20mm 1A signal supply fuse 
FU-8A-003 - 5 x 20mm 8A logic supply fuse 

SI/O Card Versions 

 
Part No  Description 
CB6648POP1 Used on standard versions with remote power supplies 
CB6648POP3 Used on versions with RS485 communications & remote 

power supplies  
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Systems using Internal Power Cards 

When internal power supply cards are used the logic voltage is internally 
connected and +V is used to provide a 1A 24VDC output for use as a signal 
supply voltage.  
 
Fuse F1 (5 x 20 mm 1A), is provided on the underside of the power input card 
to protect the 24VDC output. 
 

REAR VIEW

OV OV +V+V 0VC+VC

Rx F1 F2 Tx

24VDC OUTPUT
(+)

(OV)

F2

1A

UNDERSIDE VIEW OF

POWER INPUT CARD

SIGNAL

FUSE

1A

F1

2A

24VDC

OUTPUT

FUSE
2A

 
 
Fuses  
FU-1A-002 - 5 x 20mm 1A signal supply fuse 
FU-1A-002 - 5 x 20mm 1A – 24vdc output protection fuse 

SI/O Card Versions 

 
Part No  Description 
CB6648POP2 Used on standard versions with integral power supplies 
CB6648POP4 Used on versions with RS485 communications & integral 

power supplies  
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SECTION 4 - SIGNAL SUPPLY VOLTAGE SETTING 

24V or 125V AC/DC Signal Inputs  

 
On standard 725B systems each 4 channel alarm card is suitable for use with 
24V or 125V AC/DC signal inputs.  
 
Each channel on the alarm card is equipped with a 3 pin header and 2 way 
shorting bar that allows the user to set the input to match the required signal 
input voltage level. 
 
 

L
K

1
L

K
2

L
K

3
L
K

4

125V 24V

24V125V

125V 24V

OR

L
K

1
L

K
1

SIGNAL SUPPLY

VOLTAGE SETTING

CHANNEL 1

CHANNEL 1

CHANNEL 2

CHANNEL 4

CHANNEL 3

SIGNAL SUPPLY

SET TO 24V

SIGNAL SUPPLY

SET TO 125V

 
The above settings are available on the following (4) channel alarm cards 
 
Card Type Features 
CB6611POP1 24/125V Signal Input  
CB6611POP3 24/125V Signal Input plus 3 x Pushbutton Inputs  
CB6611POP5 24/125V Signal Input and Time Stamping Option 
CB6611POP7 24/125V Signal Input plus 3 x Pushbutton Inputs and 

Time Stamping Option 
 
Differential Input Versions 
 
Card Type Features 
CB6611POP9 24/125V Differential Signal Inputs  
CB6611POP11 24/125V Differential Signal Inputs plus Time Stamping 

Option  
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48V or 250V AC/DC Signal Inputs  

 
As an option each 4 channel alarm card can be supplied suitable for use with 
48V or 250V AC/DC signal inputs.  
 
Each channel on the alarm card is equipped with a 3 pin header and 2 way 
shorting bar that allows the user to set the input to match the required signal 
input voltage level. 
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The above settings are available on the following (4) channel alarm cards 
 
Card Type Features 
CB6611POP2 48/250V Signal Input  
CB6611POP4 48/250V Signal Input plus 3 x Pushbutton Inputs  
CB6611POP6 48/250V Signal Input and Time Stamping Option 
CB6611POP8 48/250V Signal Input plus 3 x Pushbutton Inputs and 

Time Stamping Option 
 
Differential Input Versions 
 
Card Type Features 
CB6611POP10 48/250V Differential Signal Inputs  
CB6611POP12 48/250V Differential Signal Inputs plus Time Stamping 

Option  
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24VAC/DC Signal Inputs 

 

WR
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Each channel on the alarm card is provided with a 3 pin header and 2 way 
shorting bar which allows the user to select the inputs to operate on either 
24VAC/DC or 125VAC/DC. 
 
On standard 725B systems the 24VDC logic supply is linked as follows - OV 
and OVC and +V and +VC this provides a 24VDC signal contact supply on all 
C terminals as shown above.  
 
LED F2 is used to indicate that the signal supply, (+VC), fuse has blown. 
 
As all *C terminals are internally linked the customer can connect each input 
contact to a dedicated terminal as shown in the middle cell or a single feed 
can be used for multiple contacts as shown in the right hand cell. 
 
Inputs are bi-polar and therefore 24VAC or 24VDC can be used as a signal 
supply however if 24VAC is required the link between the logic supply and the 
signal supply must be removed and the 24VAC must be externally sourced. 
 
The common return for all remote pushbuttons is +V (+24VDC) 
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Optional 125VAC/DC Signal Inputs 

WR
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Each channel on the alarm card is provided with a 3 pin header and 2 way 
shorting bar which allows the user to select the inputs to operate on either 
24VAC/DC or 125VAC/DC. 
 
On 725B systems where 125VAC/DC is required as a signal supply voltage 
this needs to be derived externally and connected to terminals OVC and +VC 
as typically shown above.  
 
LED F2 is used to indicate that the signal supply, (+VC), fuse has blown. 
 
Fuse F2, (5 X 20mm 1A), is provided on the power input card to protect the 
signal supply voltage and the 125VAC/DC is internally linked to all associated 
input card *C terminals to allow distribution to the external field contacts. 
 
As all *C terminals are internally linked the customer can connect each input 
contact to a dedicated terminal as shown in the middle cell or a single feed 
can be used for multiple contacts as shown in the right hand cell. 
 
Inputs are bi-polar and therefore an externally derived 125VAC or 125VDC 
can be used as a signal supply as required. 
 
The common return for all remote pushbuttons is +V (+24VDC) 
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Optional 48VAC/DC Signal Inputs 

WR
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Note:- In applications that require 48VAC/DC signal inputs RTK supply 
optional 4 channel alarm cards in place of the standard version  

48VAC/DC Signal Supply 

Each channel on the alarm card is provided with a 3 pin header and 2 way 
shorting bar which allows the user to select the inputs to operate on either 
48VAC/DC or 250VAC/DC. 
 
On 725B systems where 48VAC/DC is required as a signal supply voltage this 
needs to be derived externally and connected to terminals OVC and +VC as 
typically shown above.  
 
LED F2 is used to indicate that the signal supply fuse has blown. 
 
Fuse F2, (5 X 20mm 1A), is provided on the power input card to protect the 
signal supply voltage and the 48VAC/DC is internally linked to all of the 
associated input card *C terminals to allow distribution to the external field 
contacts. 
 
As all *C terminals are internally linked the customer can connect each input 
contact to a dedicated terminal as shown in the middle cell or a single feed 
can be used for multiple contacts as shown in the right hand cell. 
 
Inputs are bi-polar and therefore an externally derived 48VAC or 48VDC can 
be used as a signal supply as required. 
 
The common return for all remote pushbuttons is +V (+24VDC) 
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Optional 250VAC/DC Signal Inputs 

WR

725B SMALL WINDOW VERSION TYPICAL REAR VIEW

OV OV +V+V OVC +VC

Rx F1 F2 Tx

250VAC/DC SIGNAL 

CHANNEL

21

5 - 8

3C

INPUTS

43 1C 2C

A

4C

AP

INPUTS

CHANNEL

31 2 1C4

1 - 4

P3P1 P2CR1 CR2 CR3 CR4

F2 - 1A

SUPPLY VOLTAGE

EXT PB

INTERNAL SIGNAL

SUPPLY COMMON

CELL 2 CELL 1 CELL 0

+V

Note:- In applications that require 250VAC/DC signal inputs RTK supply 
optional 4 channel alarm cards in place of the standard version  

250VAC/DC Signal Supply 

Each channel on the alarm card is provided with a 3 pin header and 2 way 
shorting bar which allows the user to select the inputs to operate on either 
48VAC/DC or 250VAC/DC. 
 
On 725B systems where 250VAC/DC is required as a signal supply voltage 
this needs to be derived externally and connected to terminals OVC and +VC 
as typically shown above.  
 
LED F2 is used to indicate that the signal supply fuse has blown. 
 
Fuse F2, (5 X 20mm 1A), is provided on the power input card to protect the 
signal supply voltage and the 24VDC is internally linked to all associated input 
card *C terminals to allow distribution to the external field contacts. 
 
As all *C terminals are internally linked the customer can connect each input 
contact to a dedicated terminal as shown in the middle cell or a single feed 
can be used for multiple contacts as shown in the right hand cell. 
 
Inputs are bi-polar and therefore an externally derived 250VAC or 250VDC 
can be used as a signal supply as required. 
 
The common return for all remote pushbuttons is +V (+24VDC) 
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Optional Differential Input Version  

As an option RTK can supply fully isolated inputs for each alarm way.  
 
As the Inputs are bi-polar the user can switch AC or DC voltages as required. 
 

WR

725B SMALL WINDOW VERSION TYPICAL REAR VIEW

OV OV +V+V OVC +VC

Rx F1 F2 Tx

CHANNEL

21

5 - 8

3C

INPUTS

43 1C 2C

A

4C

A

INPUTS

CHANNEL

31 2 1C4

1 - 4

4C2C 3CCR1 CR2 CR3 CR4

EXT PB

INTERNAL SIGNAL
SUPPLY COMMON

CELL 2 CELL 1 CELL 0

(+) (+) (+) (+) (-)(-) (-)(-)

TYPICAL CUSTOMER 

SUPPLIED 
24VDC INPUTS

C
H

-5

C
H

-6

C
H

-7

C
H

-8

C
H

-5

C
H

-6

C
H

-7

C
H

-8

C
H

-1

C
H

-2

C
H

-3

C
H

-4

C
H

-1

C
H

-2

C
H

-3

C
H

-4

TYPICAL CUSTOMER 

SUPPLIED 
24VDC INPUTS

(+) (+) (+)(+)(-)(-) (-) (-)

 
In the above typical example cell 0 is shown with OV switched inputs and cell 
1 is shown with +24V switched inputs 
 
Standard 24V/125V AC/DC Version 
Each (4) channel alarm card is provided with a 3 pin header and 2 way jumper 
link per channel which allows the user to select the input for use with either 
24V or 125V as required. 
 
Optional - 48V/250V AC/DC Version 
Each (4) channel alarm card is provided with a 3 pin headers and 2 way 
jumper link which allows the user to select the input for use with either 48V or 
250V as required. 
 
 
 
 
 
 



Series 725B Instruction Manual – Rev 5 
 

Page 46 of 169 

SECTION 5 – COMMON RELAYS 

WR

RELAY OUTPUTS

CR1

REAR VIEW

CB6641POP1   - WATCHDOG / RELAY CARD

RELAY CARD VERSION USED IN "WR" CELLS

(LOWER SLOT)

CR2 CR3 CR4

Four common relays are located in the WR Cell within the Annunciator as 
shown above.  
 
Each relay is equipped with a C/O contact and the user can select the contact 
state to N/C or N/O using a 3 way header and 2 way shorting bar located on 
the card as shown below. 
 

NO LK3 NC

RL3

OR

NO LK4 NC

NO LK4 NC

NORMALLY

OPEN

NORMALLY

CLOSED

RL4

RELAY

CONTACT

STATE

NO LK4 NC

RL2 RL1

NO LK1 NCNO LK2 NC

CARD ADDRESS

DIL SWITCH SW1

SW1

 
 
The coil state of each relay can be set to EN or DE-EN as described in the 
software configuration section of this manual.  
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Multiple common relay cards may be present in larger systems to provide the 
necessary features. 
 
The function of each common relay can be set within the software allowing 
the relay to operate as:- 

Group Relay 

Once channels have been assigned to groups and the “group operation” has 
been defined the user is able to link a group to a common relay under the 
“WR” Tab within the software  
 
The common relay will therefore act in accordance with the selected “group 
operation” which can be one of the following:-  
 

First-Up  
Activates when the first alarm occurs within a group 

 
Input  
Activates on alarm and remains active until the input has returned to 
normal. 

 
Alarm  
Activates on alarm and remains active until the input has returned to 
normal and the alarm has been reset to the off state 

 
Audible  
Activates on alarm and remains active until the mute or acknowledge 
pushbutton has been pressed. 

Group Relay with Reflash 

A common relay can be set to reflash each time a new event occurs within the 
group to prevent subsequent events being masked by a standing alarm 

Pushbutton Follower Relay 

Any common relay can be set to follow the action of any pushbutton.  
 
The common relay function should be set to match the required pushbutton 
i.e. if lamp test is selected the common relay contact will activate in sympathy 
when the lamp test pushbutton is pressed. 
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Diagnostic / Watchdog Relay 

Any common relay can be set to operate as diagnostic / watchdog relay to 
provide a volt free contact for use with 3rd party devices to indicate that a fault 
has occurred within the annunciator. 
 
The following options are available:- 

All Faults Monitoring 

The common relay will activate when any error is detected within the system 

Field Contact Monitoring 

If the signal supply used to initiate each alarm channel is lost or the internal 
signal supply protection fuse has blown the relay will change state and will 
remain in the abnormal state until power has been restored. In addition the 
system can provide an indication of line resistance  

System Fault Monitoring 

If a system fault is detected within the unit the relay will change state and will 
remain in the abnormal state until the system is functioning correctly. 

Communication Failure Monitoring 

If the system detects a loss of data on the communication link the relay will 
change state and will remain in the abnormal state until communications are 
functioning correctly 

Power Failure Monitoring 

If the 24VDC logic power fed to the annunciator is lost or the internal logic 
supply protection fuse has blown the relay will change state and will remain in 
the abnormal state until power has been restored.  

Card Fault Monitoring 

If any of the cards within the system are not functioning correctly the relay will 
change state and will remain in the abnormal state until the card functions 
correctly. 

Ground Fault Monitoring 

If the optional ground fault monitoring card is fitted the common relay will 
change state whenever a ground fault is detected and will remain in the 
abnormal state until the ground fault has been cleared. 

LED Failure Monitoring 

If any window suffers a total failure of the LED assemblies the common relay 
will change state and will remain in the abnormal state until illumination is 
restored. (Please note:- The system checks for LED failure on an hourly 
basis) 
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GPS Monitoring 

On systems supplied with optional time stamping and GPS time sync. the 
common relay will activate if the GPS time sync. is not available. 

Printer Fault Monitoring 

On systems supplied with optional time stamping and online printing of alarms 
the common relay will change state when any printer errors occur and will 
remain in the abnormal state until the printer error has been resolved. 

Real Time Clock Fault Monitoring 

The common relay will change state if any faults are detected in the RTC and 
will remain in the abnormal state until the RTC returns to normal. 
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SECTION 6 – INDIVIDUAL CHANNEL REPEAT RELAYS 

 
Each four channel alarm card can be supplied with an optional four channel 
relay card, part no CB6613POP1, which plugs into the four channel alarm 
card and provides the user with a volt-free contact per alarm channel for use 
with 3rd Party devices.  
 
Each relay is equipped with a C/O contact and the user can select the contact 
state to N/C or N/O using a 3 way header and 2 way shorting bar located on 
the card as shown below 
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Each relay can be configured in software to operate in accordance with one of 
the following:- 

Input Follower 

The relay changes state each time there is a change to the associated signal 
input contact. 

Logic Follower 

The relay changes state on alarm and remains in the abnormal state until the 
input has returned to normal and the logic has been reset using the 
pushbuttons associated with the ISA sequence set for this channel. 

Display Follower 

The relay changes state on alarm and faithfully follows the display window i.e. 
Flashing, Steady or Off depending on the alarm sequence selected for this 
channel. 
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SECTION 7 - TYPICAL 725B REAR VIEWS 

 
The following details are provided as typical examples of 725B Annunciator 
rear views showing alarm inputs, remote pushbutton inputs, common alarm 
relay outputs, 24VDC logic and signal wiring 
 
Typical Large Window Version,  
(each alarm window = 60mm w x 60mm h) 
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The above rear view shows a typical large window 725B annunciator 4 cells 
wide x 2 cells high with seven active alarms, common relay card and an 
integral pushbutton module.  
 
Each cell within the Annunciator is used to display a single channel. 
 
In the example shown the top right hand cell is equipped with a four channel 
alarm card plus provision for three remote pushbutton inputs. 
 
In large window versions of the 725B only the first cell in a group of four is 
supplied with an alarm card and the outputs are distributed to the next three 
cells – working down in columns then moving onto the next row.  
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Typical Medium Window Version,  
(each alarm window = 60mm w x 30mm h), 
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The above rear view shows a typical medium window 725B configured 4 cells 
wide x 2 cells high with fourteen active alarms, common relay card and an 
integral pushbutton module.  
 
Each cell within the Annunciator is used to display two alarm channels. 
 
In the example shown the top right hand cell is equipped with a four channel 
alarm card plus provision for three remote pushbutton inputs. 
 
In medium window versions of the 725B only the first cell in a group of two is 
supplied with an alarm card and the outputs are distributed to the next cell  – 
working down in columns and then moving onto the next row. 
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Typical Small Window Version, (each alarm window = 30mm w x 30mm h), 
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The above rear view shows a typical small window 725B configured 4 cells 
wide x 2 cells high with twenty eight active alarms, common relay card and an 
integral pushbutton module.  
 
Each cell within the Annunciator is used to display four alarm channels. 
 
In the example shown the top right hand cell is equipped with a four channel 
alarm card plus provision for three remote pushbutton inputs. 
 
In small window versions of the 725B each cell is supplied with an alarm card 
and the outputs are distributed to four channels within the cell. 
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 SECTION 8 - INSTALLATION 

Unpacking 

Once the item has been unpacked please visually examine the unit for any 
signs of transit damage before installing the unit into the control system. If any 
damage has occurred please report the damage to the freight forwarder and 
copy RTK. The alarm annunciator is supplied with panel mounting clamps 
locked in place, however please check all packages to ensure that no 
additional pieces are left in the box as any auxillary items like power supplies, 
horns, pushbuttons or spares kits will be packed separately.  
 
Please double check that all items listed on the packing list have been 
unpacked before disposing of any packing material. 

Mounting 

Standard 725B units are designed for panel mounting, as an option they can 
be supplied fitted within 19” filler plates to allow direct mounting into Industry 
standard 19” rack systems or fully integrated into wall or floor standing panels. 

Panel Mounting 

 

CABINET DIMENSIONS IN MM 
WIDE HIGH 

Cells Overall Cut-Out Cells Overall Cut-Out 

1 88 74 1 88 74 

2 148 134 2 148 134 

3 208 194 3 208 194 

4 268 254 4 268 254 

5 328 314 5 328 314 

6 388 374 6 388 374 

7 448 434 7 448 434 

8 508 494 8 508 494 

9 568 554 9 568 554 

10 628 614 10 628 614 

11 688 674 11 688 674 

12 748 734 12 748 734 

13 808 794 13 808 794 

14 868 854 14 868 854 

15 928 914 15 928 914 

16 988 974 

X 

16 988 974 

 
Please note:-  
The cut out tolerance should be with ±2mm. 
 
Annunciator depth is 143mm 
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Caution 
The above table indicates the dimensions based on the number of cells high 
and wide this should not be confused with the number of alarm windows.  
 
The number of windows available per cell is determined by the window style 
 
Window Style Window Size mm Alarms PER cell 

Large 60 W x 60 H 1 

Medium 60 W x 30 H 2 

Small 30 W x 30 H 4 

 

19” Rack Mounting 

725B Alarm Annunciators are suitable for mounting within 19” racks using 
suitable filler plates which can be supplied as optional items. 
 
Units from 1 to 7 cells wide are possible within the 19” rack dimensional limits 
 
The number of cells high is dependant on the available space available within 
the 19” rack. 

Wall Mounting 

RTK offer a full integration service where Panel mounted Annunciators are 
supplied within an industry standard Wall mounting Enclosure, with all 
customer connections typically wired to Weidmuller terminals for ease of 
connection to the field device. 

Floor Standing 

RTK offer a full integration service where Panel mounted Annunciators are 
supplied within an industry standard Floor Standing Enclosures, with all 
customer connections typically wired to Weidmuller terminals for ease of 
connection to the field device. 
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 SECTION 9 - SOFTWARE INSTALLATION 

725B Configurator Installation 

The configuration program and associated drivers are supplied on a CD along 
with a USB cable. Before connecting the cable to the Annunciator please 
ensure the software has been loaded onto a local PC or laptop.  
 
First place the CD into the associated Drive and locate the file titled 
RTKConfiguratorInstaller.exe. If you require desktop and start menu short 
cuts please tick the option boxes as shown below. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After the program has been installed, please ensure the Annunciator is 
powered and then the pushbutton faceplate can be removed to expose the 
USB port as described below: 
 
A small flat blade screwdriver can be used to gently ease the top edge of the 
pushbutton face plate out which allows access the USB programming port 
which can be used to:- 
 

4. Upload a configuration from an existing 725B 
5. Download a configuration to the 725B 
6. View diagnostic data whilst fault finding.  

 
 

 
 
 
 
 
 
 
 
 

USB Port 
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USB Drive Installation  
With the Annunciator powered plug the USB cable into the USB Port and the 
other end of the cable into the PC or laptop. 
 
 
 
 
 
 
 
 
 
The “Found New Hardware” Balloon will appear. Click on the balloon to 
launch the New Hardware Wizard. Select “Install from a specific location” 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Click next and note the root path shown next to the browse control button in 
the details below. If this path is not visible use browse to locate the following: - 
“C:\Program Files\RTK Instruments\Configurator\drivers” 
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During the driver install, an information box appears. Please select the 
“Continue Anyway” button to proceed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The associated drivers should now be fully loaded and ready to use. 
 
The following screen appears once the software has been initialised which 
invites the user to select the hardware type to be configured as shown below. 
 

  
 
Select the 725B radio button using a left mouse click and once this has been 
selected the user is prompted to select one of three options:- 
 

 

Auto Detect Hardware Configuration. 

If a 725B System is connected to the associated PC via the USB 
programming port and communication has been established the software will 
be able to read the configuration data direct from the annunciator system. 
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Load from a Saved File 

If a 725B configuration file has been previously saved the user can load the 
data to the configuration software using “Load from a saved file” and normal 
Microsoft Windows ® navigation techniques to select the stored data. 
 

Create a New System 

This menu is greyed out and the feature is only used during the manufacturing 
process to define the system structure. 
 
After the software has loaded the user is able to access the following Menu’s 
 

File Menu 

The File Menu provides access to the following:-. 
 
 

 
 

Open Configuration 

Selecting the File Menu followed by “Open Configuration” allows a previously 
saved configuration file to be uploaded. Standard Microsoft Windows ® 
navigation techniques allow the user to locate the file and a left mouse click 
on the “Open” command button uploads the configuration for review or 
modification.   
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Save Configuration (*.rtk) 

Once the user has created a “new” or modified an “existing” configuration the 
associated file can be saved using the File Menu followed by “Save 
Configuration”. Standard Microsoft Windows ® navigation techniques can be 
used to define the location and after a file name has been defined a left 
mouse click on the “Save” command button completes the process. 

Export Spreadsheet 

Once a configuration has been defined the user is able to export all of the 
configuration data to a Microsoft Excel spreadsheet for record purposes. 

Print Image 

The configuration software provides access to front or rear views of the 
annunciator and these views can be printed if required. Once “Print Image” 
has been selected additional sub menus are available to allow selection of 
printer type, page size, orientation etc. 

Print Legends 

The configuration software allows the user to define the alarm legends for 
each channel as described later in this manual.  
 
Once the Legend details have been entered into the software the user can  
 

1. Print a paper copy of the legends for record purposes  
 
2. Use acetate film in a laser printer to print the alarm legends which can 

be fitted to the alarm annunciator as required. 
 

Export Legends 

As an alternative the user can save an electronic copy of the legend details 
using the “Export Legends” menu and standard Microsoft Windows ® 
navigation techniques to save the file in Microsoft Excel format. 
 

Exit 

The “Exit” Menu allows the user to quit the application but please ensure that 
you save any configuration changes before selecting exit. 
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View Menu 

The following options are available under the “View” menu 
 

Normal View 

In the “Normal View” the number of groups displayed is limited to 8. A max of 
32 Groups are available within the 725B for use as Horn, First Up or Common 
Alarm groups and the additional groups are accessed under the advanced 
view. 
 

 
 

Advanced View 

In more complex applications the “Advanced View” allows full access to all 32 
groups and other advanced features within the annunciator as shown in the 
example below. 
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Show Legends 
The alarm text and colour of each alarm way can be displayed within the 
configuration software by selecting the “View” menu followed by the “Show 
Legends” as shown below. Channel numbers are used as default to identify 
each alarm way and the nameplate colour is set to red however the user is 
able to edit the text and colour of each channel to match the annunciator 
fascia and to aid navigation within the software. 
 

 
 
As a default the window colour is Red and the channel number is used to 
identify each alarm way. The user is able to edit the alarm text and colour of 
each channel to provide a clearer view and to aid navigation within the 
software. 
 

Front View 

The front view of the alarm Annunciator is displayed by default to simplify 
configuration. This view is defined under the “View” menu followed by “Front 
View” as shown below. 
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Rear View 

As an alternative the rear view of the alarm annunciator can be displayed 
showing details of the associated cells.  
 
This view is accessed using the “View” menu followed by “Rear View” as 
shown below. 
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Tools Menu 
 
The following options are available under the “Tools” menu 
 

 
 

Send Settings 

Selecting the “Send Settings” menu allows the user to transmit the 
configuration to the associated 725B Annunciator. Once selected the 
Communications Port will be displayed and the “Send” command key should 
be pressed using a left mouse click. 
 

 
 
 
If an annunciator is not detected the following error message will be 
displayed. 
 

 
 
 
 
 
 
 
 
 



Series 725B Instruction Manual – Rev 5 
 

Page 65 of 169 

If communication is established a status bar is used to provide a visual 
indication of progress as shown below. 
 

 
 

Receive Settings 

Selecting the “Receive Settings” menu allows the user to read the 
configuration from the associated 725C Annunciator. Once selected the 
“Read” command key should be pressed using a left mouse click. 
 

 
 
If an annunciator is not detected the following error message will be 
displayed. 
 

 
 
 
Once communication has been established a status bar is used to provide a 
visual indication of progress as shown below. 
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Synchronise Time 

725B Systems are available with a Sequential Event Recording option which 
provides Time Stamping of each alarm to a minimum of 1ms resolution. The 
time stored within the 725B system can be synchronised to the PC by 
selecting “Tools” and “Synchronise Time” menu. 
 
Once selected the user is presented with the following screen 
 

 
 
If the user wishes to proceed a left mouse click from the “Synchronised” 
command button will commence transmission between the PC and the 
Annunciator. 
 
A status bar provides indication of transmission, and once it has reached 
100% the user can close the associated window. 
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Clear Buffers 

 
CAUTION 
The user must be aware that this command erases ALL historical alarm data 
therefore this command should be used with caution. 
 
Event Buffers are provided within the 725B Annunciator to store alarm data 
and time stamp information for future analysis however during the installation 
and commissioning phase these buffers can contain a large number of false 
alarm data. Selecting the “Tools” and “Clear Buffers” menus provides access 
to the following screen. 
  

 
 
Selecting the “Clear” command button using a left mouse click will erase all of 
the stored data and a status bar is used to indication progress. 
 

 
 
Once the “Status Bar” has reached 100% the window can be closed. 
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Restore System Settings to Default 

If the software has been used to trial configurations the unit can be returned to 
factory default settings using the “Tools” menu followed by “Restore System 
Settings to Default” as shown below. 
 

 
 
CAUTION 
This setting will automatically convert ALL of the Systems options to the 
factory default setting and therefore it should only be used with caution. Full 
details of default settings are provided in the rear of this manual. 
 

Help 

Dynamic help screen provide help for specific features as required. At any 
time the user can select the “Help” Menu to access information on the 
selectable features of the 725B. 
 
The user is able to search by topic and navigate forward and backwards 
within the help call out screens as required. 
 

About Configurator 

This allows the user to view the revision number of the configuration software 
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Diagnostics 

All units are supplied with an inbuilt diagnostic facility which allows the user to 
connect the supplied USB cable to a PC equipped with the configuration 
software to provide dynamic diagnostic feedback. 
 

 
 
Once selected the following screen will appear  
 
 

 
 
 
If no errors are detected the diagnostic window will be blank as shown above 
 
Example 1 
In the typical example shown below the signal supply voltage has not been 
detected, typically as a result of a blown fuse, and the error message 
indicates that the user should check the field contact supply. 
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Example 2 
In the example shown below a watchdog alarm is present as the system has 
detected an error with an alarm card, (address 2), which has not been 
detected. 
 

 
 

LED Failure Alarm 

Each channel within the annunciator is equipped with plug in LED assemblies 
which provide the window illumination. If a window suffers a total loss of 
LED’s the watchdog LED located on the pushbutton module will flash and 
software diagnostics can be used to provide indication as typically shown 
below 
 

 
 
A common relay can be set to operate when LED failure has been detected if 
required. 
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Add / Remove Cards 

The user is able to use this feature to remove specific cards in software by 
selecting the “View” Menu followed by rear view and then a right mouse click 
over the rear terminal view of the specific card allows the user to select 
Remove Card as shown below. 
 

 
 
Once a card has been removed in software the associated terminal view 
changes to yellow from green to indicate that the card is no longer present. 
 
If the user wishes to complete the removal of the card from software the 
“Tools” menu provides access to the Add/Remove Cards download function 
as shown below 
 

 
 
Once selected the user will be prompted to press the Add/Remove control 
button to confirm that they wish to proceed 
 

 
 
Once the control button has been pressed the download status is provided to 
confirm data transfer or an error flag will appear if problems occur.  
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SECTION 10 – AUTO DETECT HARDWARE. 

 
The user is able to “Auto Detect Hardware Configuration” after loading the 
software and connecting the USB cable to the associated ports. 
 
Once the application has been launched the user can select the 725C radio 
button using a left mouse click.  
 

  
 
After pressing the “Confirm” button the user is prompted to select one of three 
options:-  
 
To upload the setting from a 725B select “Auto Detect Hardware 
Configuration” 
 

 
 
Once the confirm radio button has been pressed using a left mouse click the 
user will be prompted with a Detect radio button as shown below. 
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If an annunciator is not detected the following error message will be 
displayed. 
 

 
 
If any conflicts are found during the detection process an error message will 
provide diagnostic details to assist the user with fault finding. 
 

 
 
In this example the card set to address 2 has not been successfully detected 
and the auto detect halts until the user resolves the issue 
 
If a 725B System is connected to the associated PC and communication has 
been established the software will be able to read the configuration data direct 
from the annunciator system.  
 
Once upload is complete the Annunciator graphic should match the supplied 
instrument and the associated fields will indicate all of the configured features.  
 
Please refer to Section 6 & 7 for details of configurable options 
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SECTION 11 – CREATE A NEW SYSTEM 

This section is used by the factory to define the structure of the system prior 
to delivery 

Physical Size Tab  

A drop-down menu is provided to the right of each of the following three fields 
to allow the cabinet to be defined. The graphical view of the Annunciator is 
dynamically updated as selections are made. 

Window Size 

The window size defines the number of windows available in each 60mm x 
60mm cell in accordance with the following chart. 
 

Window Style Window Size (W x H) Alarms per Cell 
Large 60mm x 60mm 1 

Medium 60mm x 30mm 2 
Small 30mm x 30mm 4 

Windows Wide 

Once a window size has been assigned the user is able to select the total 
number of windows wide within the range defined below.  
 

Window Style WINDOWS WIDE 
Large Selectable from 1 to 16 Wide 

Medium Selectable from 1 to 16 Wide  
Small  Selectable in pairs from 2, 4, 6, 8, 10, 12, 14 to 16 Wide 

Windows High 

Once a window size has been assigned the user is able to select the total 
number of windows high within the range defined below. 
 

Window Style WINDOWS HIGH 
Large Selectable from 1 to 16 Wide 

Medium Selectable from 1 to 16 Wide  
Small  Selectable in pairs from 2, 4, 6, 8, 10, 12, 14 to 16 Wide 

 

Pushbutton Module 

Standard 725B Systems are supplied with an integral pushbutton / 
programming module located in the bottom right hand corner of the 
Annunciator when viewed from the front as typically shown below.  
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To enable the integral pushbutton function the drop down menu to the right of 
the “Pushbutton Module” field needs to be selected to Integral. 
 
In standard systems the Pushbutton module is located in the bottom right 
hand corner as shown above.  
 
Once the user has configured the basic unit a left mouse click on the “Next” 
control button navigates to the “Window Configuration” screen. This screen is 
only required in applications that use mixed window sizes.  
 
The “Next” control button can be used to proceed with configuration. 
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Window Configuration Tab 

This section is only used in systems supplied with mixed window sizes on 
standard system the user can bypass this screen using the “Next” control 
button.  
 

Mixed Window Sizes 

The “Window Configuration” Tab allows the user to define the window style of 
each cell. A left mouse click on one of the four cells shown under the tab 
automatically copies the style. The selection is confirmed when a red border 
appears around the icon as typically shown below. A left mouse click into any 
cell in the annunciator graphic pastes the style. 
 
 

 
 
 
 
The “Next” control button can be used to proceed with configuration. 
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Repeat Relays and Power Tab 

This tab provides access to the fields associated with optional repeat relay per 
channel facilities and Integral Power Supplies.  
 

No Repeat Relays 

On standard systems there individual channel repeat relays are not fitted and 
therefore the drop down menu is set to “No Repeat Relays”. 
 

Repeat Relays 

As an option each channel can be supplied with a dedicated repeat relay 
facility to provide an isolated output for use with 3rd party devices.  
 
In these applications the drop-down menu needs to be set to “Single Repeat 
Relay Per Channel” as shown below.  
 

 
 
Dual Repeat Relays 
As an option each channel can be supplied with dual repeat relays to provide 
two isolated outputs for use with 3rd party devices.  
 
In these applications the drop-down menu needs to be set to “Dual Repeat 
Relays Per Channel” as shown below 
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Power Supply 

725B Systems operate on a logic voltage of 24VDC and this can be supplied 
via External or Internal Power Supplies. 
 

External Power Supply 

In Systems using an externally derived 24VDC the drop down menu under the 
“Power Supply Field” needs to set to be “External Power Supply” as shown 
below. 

Integral Power Supply 

If the annunciator system is directly powered from either 72 to 144VDC or 85 
to 264VAC integral universal power supplies are used to convert to 24VDC 
and the drop down menu needs to be set to “Integral Power Supply”. 
  

 
 
 
 
 
 
 
 
 
The “Next” control button can be used to proceed with configuration. 
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Alarm Inputs and Remote Pushbuttons Tab 

Alarm Inputs  

Standard systems use optically isolated digital inputs fed via a volt-free 
contact or externally powered device. In these applications the standard input 
radio button is checked as shown below.  
 

.  
 
If the annunciator has been supplied with the differential input option, which 
provides fully isolated inputs per alarm channel, the Differential input radio 
button is checked.  
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Number of Remote Pushbuttons 

On standard 725C Systems 3 control Inputs are provided as standard on the 
first alarm card in the system for use with external control inputs typically used 
when remote pushbuttons or remote Inhibit switches are required.  
 
Example 1 
 
Function Required Number of Remote Inputs Required 
System Test 1 
Acknowledge 1 
Reset 1 
Total 3 
 
In this application the 3 control inputs provided as standard are sufficient for 
the application and the “Number of Remote Pushbuttons” Field should be set 
to 3 as shown below. 
 

 
 
Example 2:- Remote Pushbuttons plus Inhibit Group Inputs 
 
Function Required Number of Remote Inputs Required 
Lamp Test 1 
Silence 1 
Acknowledge 1 
Reset 1 
Inhibit Group 1 1 
Inhibit Group 2 1 
Total 6 
 
In this application 3 control inputs are insufficient therefore a second alarm 
card would also require 3 control inputs.  
 
The “Number of Remote Pushbuttons” Field should be set to 6 as shown 
below. 
 

 
 



Series 725B Instruction Manual – Rev 5 
 

Page 81 of 169 

 
Example 3:- Remote Pushbuttons plus Sleep Mode Input 
 
Function Required Number of Remote Inputs Required 
System Test 1 
Acknowledge 1 
1st Reset 1 
Sleep Mode 1 
Total 4 
 
In this application 3 x control inputs are provided on the first alarm card in the 
system and a second alarm card would be provided with 3 x control inputs. (2 
x available for future use)  
 
The “Number of Remote Pushbuttons” Field should be set to 6. 
 
Example 4:- 2 x Remote Pushbutton Groups plus 2 x Group Inhibit 
 
Function Required Number of Remote Inputs Required 
Pushbutton Group 1  
System Test 1 
Acknowledge 1 
1st Reset 1 
Pushbutton Group 2  
System Test 1 
Acknowledge 1 
1st Reset 1 
Inhibit  
Inhibit Group 1 1 
Inhibit Group 2 1 
Total 8 
 
In this application 3 x control inputs are provided on the first alarm card in the 
system and two additional alarm cards would each be provided with 3 x 
control inputs. (1 x available for future use).  
 
The “Number of Remote Pushbuttons” Field should be set to 9. 
 
Error Message 
If the number of Remote Pushbutton Inputs selected exceeds the number of 
Alarm cards available a warning message appears to advise the user that the 
configuration is not possible. 
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Common Relays 

A four channel common relay card is provided as standard and each relay can 
be assigned to a group, fault or pushbutton. 
 
Example 1:-  1 x Horn, 2 x Common Alarm and 1 x Fault Relay 
 
Function Required Number of Common Relays 
Horn Relay 1 
Group 1 Relay 1 
Group 2 Relay 1 
System Fault Relay 1 
Total 4 
 
In this application the 4 common relays provided as standard are sufficient. 
 
The “Number of Common Relays” Field should be set to 4 as shown below. 
 

 
 
 
Example 2:-  2 x Horn, 3 x Common Alarm and 1 x Fault Relay 
 
Function Required Number of Common Relays 
Horn Group 1 Relay 1 
Horn Group 2 Relay 1 
Group 1 Relay 1 
Group 2 Relay 1 
Group 3 Relay 1 
System Fault Relay 1 
Total 6 
 
In this application the 4 common relays provided as standard are insufficient 
and an additional 4 channel common relay card would be provided. 
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Example 3-  2 x Horn, 3 x Common Alarm, 1 x Acknowledge Output and 1 x 
Fault Relay 
 
Function Required Number of Common Relays 
Horn Group 1 Relay 1 
Horn Group 2 Relay 1 
Group 1 Relay 1 
Group 2 Relay 1 
Group 3 Relay 1 
Ack PB Follower 1 
System Fault Relay 1 
Total 7 
 
In this application the 4 common relays provided as standard are insufficient 
and an additional 4 channel common relay card would be provided. 
 
The “Number of Common Relays” Field should be set to 8. 
 
Error Message 
If the number of Relays selected exceeds the space available a warning 
message appears indicating how many relays cannot be fitted.  
 
 
 
 
 
The “Next” control button can be used to proceed with configuration. 
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Additional Options 

 
Additional Options 
The following features are available as an option 
 

1. Standard Communication 
2. Advanced Communication 
3. Redundant Communication 
4. GPS synchronisation 
5. Ground Fault Detection 
6. Time Stamping 
7. Tropicalisation 

 
 

 
 
The “Next” control button can be used to proceed with configuration. 
 
The basic configuration of the system is now complete and the user is able to 
save the basic configuration for use as a master template.  
 
Saved Configuration 
The File and “Save Configuration” menu provide normal Microsoft Windows 
navigation for file saving.  
 
Once a file has been saved you will not need to define any of the 
preceding settings again.  
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SECTION 12 – SAVED CONFIGURATIONS 

 

Open Configuration 

The File and “Open Configuration” menu provides normal Microsoft Windows 
navigation allowing a previously saved configuration to be opened from the 
stored location.  
 
Once a previous configuration file has been opened the user can review 
configuration settings as detailed in Section 6 & 7. 
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SECTION 13 – SYSTEM SETTINGS 

 

General Tab 

The fields listed under the “General” tab allow the user to uniquely identify 
each Alarm Annunciator System to aid with the storage and retrieval of 
configuration data.  
 

 
 
The user can update any of the fields within the software but the changes will 
only be saved after the “Confirm Settings” control button is pressed using a 
left mouse click. 

Plant Name 

In the example shown above the annunciator is located in RTK Instruments 
Ltd.  

Description 

This field is used to identify the specific plant area or annunciator function 
within the plant..  

Tag No. 

This field allow a Customer assigned number to be used to identify a unique 
alarm annunciator.  

Serial No. 

A serial number is automatically provided once the software is communicating 
with the alarm annunciator. 
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Event Recording Tab 

If the Time Stamping option of the 725B has been supplied the user can 
enable or disable the type of events to record – using the following fields. 
 

 
 

Sequence Events 

The user is able to “Disable” the Sequence Events feature or enable recording 
of “All Events”. This would provide historical data associated with Alarm 
sequences i.e. First up information, control actions etc., 

Input Events 

The user is able to “Disable” the Input Events feature or enable recording of 
“All Events”. This would provide historical data indicating the time and date 
inputs occur and return to normal. 

Relay Events 

The user is able to “Disable” the Relay Events feature or enable recording of 
“All Events”. This would provide historical data indicating the time and date 
relays operated. 
 
The user is able to update any field within the software but the changes will 
not take effect until the “Confirm Settings” control button is pressed using a 
left mouse click. 
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WR1 Tab 

The WR1 Tab, (Watchdog / Relay), allows the user to assign any of the 
common relays for use as a Group, Pushbutton Follower or Fault Relays. 
 
On standard 725B systems one 4 channel relay card is used to provide 
common relays.  
 

 

Relay 1 – 4 (Available on all standard systems) 

A drop-down menu is accessed using a left mouse click on the control button 
associated with each Relay. This menu is used to define whether the Relay 
operates as a Group, Pushbutton Follower or Fault Relays.  
 
In some applications users require more than 4 common relays, in these 
instances a single or multiple 4 channel relay cards can be used to expand 
the system. 
 
The WR1 Tab provides configuration for a maximum of 8 Relays.  
 

Relay 1 to 8 (Relay 5 to 8 - Optional) 

In the example below one additional 4 Channel Relay card has been fitted, 
providing 8 Relays in total. 
 

 
 
If more than 8 Relays are installed two WR* Tabs will be available to 
configure Relays 9 onwards, as shown in the following typical examples. 
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WR2 Tab 

 

Relay 1 to 12 (Relay 5 to 12 – Optional) 

In the example below a total of 12 Relays are fitted with Relay 1 to 8 being 
configured under the WR1 Tab and the remaining Relays being configured 
under the WR2 Tab. 
 

 
 
This pattern continues as shown below, (4 Relays per additional card), 
 
No of Common Relays WR* Tab No Relay No 

4 WR1 1 to 4 
WR1 1 to 4 

8 
WR1 1 to 4 
WR1 1 to 4 
WR1 1 to 4 12 
WR2 1 to 4 
WR1 1 to 4 
WR1 1 to 4 
WR2 1 to 4 

16 

WR2 1 to 4 
ETC   
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Group Relay. 

Each Channel within the Annunciator can be assigned to a single or multiple 
Groups. These Groups can be software linked to any of the common relays to 
provide contact outputs for use with 3rd Party devices.  
 
In the example below Relay 1 is being assigned to Group 1 and a left mouse 
click would complete the selection.  
 
Once the Relay has been assigned the “Control Button” is automatically 
updated to indicate its function. I.E. Relay 3 has been assigned to Group 4 
and Relay 4 has been assigned as a System Fault Relay. 
 

 
 

Pushbutton  

Any one of the Common Relays can be assigned to any of the Pushbutton 
functions shown below. In this example Relay 1 has been assigned as a 
Silence Pushbutton Follower and each time the Silence Pushbutton is 
activated on the Annunciator the contacts on Relay 1 will change state. 
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Fault Relay. 

Any of the Common Relays can be assigned to a diagnostic fault condition to 
provide a contact output in the event of logic, signal supply, communication or 
system failure. In the example below Relay 4 has been assigned as System 
Fault Relay. 
 

 
 

Summary of Fault Relay function 

Field Contact 

Monitors the Field Contact voltage 

System 

Monitors the complete System. 

Comm’s 

 Monitors the Communication link 
 
Power 
Monitors the 24VDC Logic power 

Card 

Monitors individual Alarm Cards 

Ground 

For use with systems fitted with ground fault detection to indicate a ground 
fault has occurred. 
 
LED 
Provides an output if any of the LED’s used to illuminate individual windows 
becomes faulty.  
 
Please note:- The system scans the LED state on an hourly cycle or during 
power up. 

GPS 

For use with systems provided with GPS clock sync to indicate a failure 
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Printer 
For use with systems provided with time stamping and printers to indicate that 
a printer failure has occurred. 
 
Real Time Clock 
Used to indicate a failure in RTC time sync. 
 
As well as being able to set the function of each relay the user can set the non 
alarm coil state of each relay as follows:- 

Coil Status 

The Coil Status of each Relay can be set using the drop-down menu. In the 
example below Relay 1 has been set to Normally De-Energised. 
 

 
 

Reflash Pulse Length 

Common Alarm Relays change state on alarm and remain active until the 
alarm has been cleared.  
 
When multiple alarms appear in the same group “Reflash” is used which 
allows the Relay to drop out and re-alarm each time a new alarm occurs 
within the same group.  
 
As the Common Alarm Relay Contact are used with 3rd Party devices, the 
“Reflash” pulse length can be set to match the requirements of the device. 
 

 
 
 
 
The user is able to update any field within the software but the changes 
will not take effect until the “Confirm Settings” control button is pressed 
using a left mouse click 
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Local Pushbuttons Tab 

In some applications customers prefer to disable selective Integral Pushbutton 
functions in preference to Remote Pushbutton control. 
 
The user is therefore able to enable any of  the 6 Pushbutton functions using 
the Tick-Boxes shown below. 
 

 

Remote Pushbuttons Tab 

In certain applications remote pushbuttons inputs are required. 
 
All 725B Annunciators are able to accept a minimum of 3 external control 
inputs. The first alarm card in the system can be wired to remote Pushbuttons, 
Sleep or Inhibit Group Switches as required.  
 
In applications that require more than 3 x inputs each adjacent Alarm Card 
can be provided with 3 x additional Inputs as required. 
 
A drop-down menu allows any Pushbutton function to be assigned to a Card 
capable of accepting hardwired control inputs.  
 
In the example below Lamp Test has been assigned to Card 1 Pushbutton 
input 1. Please note: Pushbutton 2 and 3 are greyed out as they have already 
been assigned to other Pushbutton functions. 
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Additional Pushbutton Groups 

In more complex applications the user may prefer to use more than one 
Pushbutton Group within the Annunciator. For example: Groups of alarms 
associated with specific plant areas can be controlled by unique externally 
mounted Pushbuttons. 
 
To access the additional pushbutton groups the user must select the “View” 
menu followed by “Advanced View” which will allow pushbutton groups 1 to 8 
to be configured as shown below.  
 
 

 
 
In the example shown 3 alarm cards are each equipped with 3 x remote 
pushbutton inputs providing 9 x inputs in total  
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Sleep Mode 

Sleep mode is typically used in sub station applications where the visual and 
audible outputs are disabled during unmanned periods to reduce the drain on 
the associated station batteries and to prevent noise pollution. 
 
Whilst in sleep mode the logic of the annunciator will continue to react in the 
normal way including the operation of common alarm relays, watchdog relays 
and optional signal duplicating relays, only the drive signals to the LED’s and 
audibles are disabled. A remote hardwired control input is required to activate 
Sleep Mode and this input needs to be wired to an alarm card fitted with 
pushbutton inputs. The Sleep function can be assigned to any available 
pushbutton input. In the example below it is being assigned to Card 1 
Pushbutton input 1. 
 

 
 
The annunciator unit can be set to sleep mode at any time using a remote 
mounting normally open maintained switch. When closed the LED’s and 
Audible Alarms are disabled to preserve power and prevent noise pollution.  
 

AP

INPUTS

1 2 3 4 P2P1C P3

CHANNEL

CUSTOMERS 

VOLT FREE 
INPUTS

1 - 4

CB6611POP3 - 24/125V SIGNAL INPUT VERSION

                         PLUS 3 x PUSHBUTTON INPUTS

CB6611POP7 - 24/125V SIGNAL INPUT VERSION 
                         PLUS 3 x PUSHBUTTON INPUTS

                         AND TIME STAMPING OPTION

CB6611POP4 - 48/250V SIGNAL INPUT VERSION

                          PLUS 3 x PUSHBUTTON INPUTS

CB6611POP8 - 48/250V SIGNAL INPUT VERSION 
                         PLUS 3 x PUSHBUTTON INPUTS

                         AND TIME STAMPING OPTION

ALARM CARD VERSIONS USED IN "AP" CELLS 

(LOWER SLOT)

EXTERNAL
SLEEP MODE

SWITCH

CELL 0 - REAR VIEW

 
 
Note: - All normal pushbutton functions are inhibited during sleep mode to 
ensure that the operator can view any alarms that occurred as soon as the 
unit is returned to its normal operational state. 
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Inhibit 

Alarm channels can be assigned to anyone of 8 Inhibit Groups (This is 
described in detail later in the manual).  
 
Each inhibit group requires the use of a remotely mounted maintained switch 
which can be wired to any alarm card fitted with the pushbutton input option. 
Once the card and pushbutton input (1, 2 or 3) have been determined the 
Input needs to be assigned to the associated Inhibit Group using the drop-
down menu. Please note if Pushbutton 1, 2 or 3 are greyed out they have 
already been assigned to other functions. 
 
In the example below Group 1 Inhibit is assigned to Card 1 Pushbutton Input 
3 and Pushbutton 1 and 2 are greyed out as they have been assigned to 
acknowledge and reset.   
 

 
 
If the Inhibit switch is selected to the closed position all of the alarms in the 
group will be “Inhibited” until the switch is returned to the off position. 
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Internal Horns Tab 

2 x Internal Horns, Horn 1 & Horn 2, are supplied with each 725B Annunciator 
and these can be assigned to follow any of the Horn Groups. 
 
In the example shown below:- 
 

1. Horn 1 has been set to follow Horn Group 1  
 
2. Horn 2 has been set to follow Horn Group 2. 

 

 
 
Please note: This describes how to assign Horn 1 and 2 to follow any Group 
which has been set to Audible under the Group Operations Tab. However 
before the internal horns will function:-  
 

1. Individual channels must be assigned to groups.  
2. The Group Operation must be set to Audible on the assigned group. 
3. The internal horns must be assigned to follow the correct group. 

 
In more complex applications additional Groups are available and either of the 
Internal Horns can be set to follow any of these groups. To access the 
additional features the user must select the “View” menu followed by 
“Advanced View”. In the example shown below Horn 1 has been set to follow 
Horn Group 9 & 10 and Horn 2 has been set to follow Horn Group 11 & 12.  
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Test Internal Horn Volume 

As Annunciators are used in areas with different levels of background noise 
the volume of each of the internal audibles can be adjusted using the slider 
bar.  
 
In the example shown below Horn 1 has been set to 100% and Horn 2 has 
been set to 50%. 
 

 
 
A test pushbutton is provided to the right of the slider bar to verify that the 
audible is working correctly.  
 
Please note the function described below that allows Horn 1 or 2 to be set to 
pulse is overridden during volume testing to make adjustment easier, as soon 
as an alarm occurs the pulse feature is re-enabled.  
 
Please note:-  
The Annunciator must be connected via the USB serial link for this feature to 
function. 
 
Horn 1 or 2 Pulse 
As an option the user can interrupt the standard audible tone using a pulse 
generator. Either of the internal horns can have this feature enabled. In the 
example shown below Horn 2 has been set to “Pulse” 
 

 
 
 
 
 
 
 
 
 
 
 
The user is able to update any field within the software but the changes 
will not take effect until the “Confirm Settings” control button is pressed 
using a left mouse click 
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Auto Acknowledge Tab 

In applications that are not manned 100% of the time, noise pollution can be 
prevented using the Automatic Acknowledge feature.  
 
This can be set using the Tick-Boxes in the “Auto Acknowledge Follows Horn 
Groups” field.  
 
The “Delay” field allows the user to enter a time Delay in seconds.  
.

 
 
Once set the system will automatically acknowledge the alarms associated 
with the selective group after the preset time period has elapsed. 
 
In more complex applications which exceed 8 Groups selecting the “View” 
menu followed by “Advanced View” allows all 32 Groups to be displayed as 
shown below. 
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Auto Silence Tab 

In applications that are not manned 100% of the time, noise pollution can be 
prevented using the Automatic Silence feature.  
 
The user can choose to automatically Silence any of the available Groups 
using the Tick-Boxes in the “Auto Silence Follows Horn Groups” field.  
 
The “Delay” field allows the user to enter a time Delay in seconds.  
 

 
 
Once set the system will automatically Silence the alarms associated with the 
selective group after the preset time period has elapsed. Please note: This 
feature only Silences the audible alarm, the visual alarm will continue to 
operate in accordance with the selected ISA sequence. 
 
In more complex applications which exceed 8 Groups selecting the “View” 
menu followed by “Advanced View” allows all 32 Groups to be displayed as 
shown below. 
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Group Operations Tab 

Any channel within the Annunciator can be assigned to a single or multiple 
Groups and once assigned the “Group Operations Tab” allows the user to 
define the function of each group. A typical configuration example is shown 
below:- 

1. Group 1 & 2 have been set as “Audible” 
2. Group 3 & 4 have been set as “Alarm” 
3. Group 8 has been set as “First Up”  

 

 
 
A drop down menu is provided below each group, which allows the user to set 
the “Group Operation” to provide one of the functions detailed below:-  
 
First-Up  
When a 1st up alarm occurs within the associated group, the group signal will 
be active until the 1st alarm has been reset. 
 

ALARM STATE GROUP 

Off Off 

1st Alarm to occur in a Group Active 

1st Alarm Reset  Off 

 
Input  
When a signal Input, on any alarm in the associated group, goes to the 
abnormal state the group signal will be active and the signal will remain active 
until the signal input returns to the non alarm state.  
 

ALARM STATE GROUP 
Off Off 

Input Abnormal Active 

Input Returns to Normal  Off 

 
1. If the signal input of another alarm within the same group is in the 

abnormal state the group signal will remain active. 
 
2. If 1 x channel within the group is in the abnormal state a 2nd alarm 

occurring within the same group will have no effect on the group signal 
as it will already be active. 

 
3. When used with “WR” common relay cards reflash can be used to 

provide a momentary pulse each time a new alarm occurs within the 
same group. 
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Alarm  
When any alarm in the associated group goes into alarm the group signal will 
be active and it will remain active until the signal input has returned to normal 
and the alarm has been cleared to the “off state” using the associated 
controlling pushbuttons.  

 

ALARM STATE GROUP 

Off Off 

Input Abnormal Active 

Input Returns to Normal  Active 

Alarm Reset to the Off State Off 

 
1. If any other alarm, within the same group, is visible on the annunciator 

because its signal input is abnormal or it is waiting to be cleared by the 
operator the group signal will remain active. 

 
2. If 1 x channel within the group is in the abnormal state a 2nd alarm 

occurring within the same group will have no effect on the group signal 
as it will already be active. 

 
3. When used with “WR” common relay cards reflash can be used to 

provide a momentary pulse each time a new alarm occurs within the 
same group. 

 
Audible  
When any alarm in the associated group goes into alarm the group signal will 
be active and it will remain active until the audible signal is cleared using the 
mute or acknowledge pushbutton.  

 

ALARM STATE GROUP 
Off Off 

Input Abnormal Active 

Silence or Ack  Off 

 
Before Groups will function:-  
 

1. Individual channels must be assigned to groups.  
 
2. The Group Operation must be set as detailed above. 

 
 
3. The Group can be assigned to Common Relays as detailed under the 

WR* Tab  
 
Advanced View 
In more complex applications, which require more than the standard 8 
Groups, selecting the “View” menu followed by “Advanced View” allows all 32 
Groups to be displayed. 
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Comm’s Tab 

The communication tab provides access to settings using the drop menus 
shown below.  
 

 
 
Communications settings are available as follows:- 
 
Protocol:- 
The following protocols can be selected using the drop down menu shown 
above. 
 

1. No Communications required 
 

2. RTK – AMS which allows the 725B to communicate with optional RTK 
supplied Alarm Management Software 

 
3. Modbus RTU Protocol for use with 3rd party devices 

 
Please Note:- The Baud Rate, Parity and Timeout Settings are only displayed 
when the user selects the Advanced View using the View Menu. 
 
Baud Rate:-  
The following baud rates can be selected using the drop down menu shown 
above. 

1. 9,600 
2. 19,200 
3. 38,400 

 
Parity:- 
The following parities can be selected using the drop menu shown above. 

1. Odd 
2. Even 
3. None 

 
Timeout:- 
If communication is not established within a specified period of time the user 
can use the watchdog facility to flag a loss of communication. As the time 
required establishing communication can vary depending on application and 
3rd party device settings the user is able to enter a timeout time in ms from 1 
to 65,536 ms 
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SECTION 14 – CHANNEL SETTINGS 

 
To configure individual channels the user must first select a window on the 
Annunciator graphic, using a left mouse click, to access additional menus. 
 
Please Note:- It is possible to programme multiple channels using one of the 
following methods:- 
  
Selective windows can be highlighted if the “Ctrl” Key on the keyboard is 
held down while you click on selective windows. Once the channels have 
been selected the user is able to select to navigate between tabs and select 
any feature. The background colour for all selectable field is White, however, 
this changes to Blue if the selective channels are not all set to the same 
function on the specific field. If the user wishes to proceed   
 
Group of windows can be highlighted if the user clicks on the first window in 
the group and then holds down the “Shift Key” on the keyboard while you click 
on the last window in the group. 

Channel Tab 

The following features are available under the “Channel” Tab. 
 

 
 



Series 725B Instruction Manual – Rev 5 
 

Page 105 of 169 

Alarm Legend 

Each of the windows within the Annunciator needs to have a unique Legend 
to help the operator identify the alarm. The user types the alarm legend into 
the alarm legend field and drop-down menus allow selection of font, style and 
size to suit each application. Once the selection has been made a “Preview” 
button allows the user to review the appearance before saving the data. The 
preview pane must be closed before the user is able to continue configuring. 
 

 
 
Once the data has been saved the user is able to Display the Legends on the 
Annunciator graphic for ease of configuration. 
 

Show the Legends  

To display Legends use the “View” Menu and select “Show Legends”.  
 

 
 

Print the Legends 

Legends can be printed for review using the “File” Menu and selecting “Print 
Legends”. 
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Export the Legends 

Legends can be exported to a Microsoft Excel Template for future reference 
using the “File” Menu and selecting “Export Legends”.  
 

 
 

Manual Inhibit 

Each Channel can be manually inhibited within the software or a Channel can 
be assigned to an Inhibit Group. Once Channels have been assigned to a 
Group and a remote pushbutton input has been configured to operate the 
same Group they can be manually inhibited via a remote switch. 
 

Inhibit Input 

To manually inhibit a Channel the Inhibit input “Tick Box” must be checked as 
shown below. 
 

 

Group 1 to Group 8  

In the “Normal view” a single inhibit group is available and any channel can be 
assigned to Group 1 and a remote pushbutton input can be used to inhibit a 
group of alarms via a remote key switch.  
 
In applications that require multiple inhibit groups the user must select the 
“View” Menu followed by “Advanced View” to access up to 8 inhibit groups. 
 
Any Input can be assigned to any inhibit group so that a number of alarms can 
be manually inhibited via a number of remote key switch.  
 
In the example below a Channel has been assigned to Inhibit Group 1 and 3. 
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Auto Shelving 

On Systems supplied with the Sequence of Events Recording option a faulty 
alarm loop or loose cable can quickly flood the associated event buffers. Auto 
shelve allows the user to configure:- 
 

Function  Description 

Alarm Count  
 

The Maximum number of alarms the user believes will occur within 
a set period before the alarm count is considered abnormal 

Count Period  The Time period in seconds 
 

If the number of Input events exceeds the abnormal count within the count 
period the Input will be automatically shelved and a dated and timed message 
will be generated to inform the user that auto shelving has occurred on the 
specific channel. Events that occurred prior to the auto shelve will be stored in 
the relevant buffers in the normal way to aid fault finding and the alarm will 
automatically drop out of auto shelve when it has returned to normal operating 
patterns. 
 
In the example below the user has indicated that 5 alarms occurring within 
1200 seconds is considered abnormal. 
 

 
 

Event Recording 

Each channel can be set to allow data to be passed to the associated event 
buffers by enabling the Event Recording “Tick-Box”. 
 

 

Colour 

Colours are often used on Annunciator Systems to assist the operator in 
identify the type of Alarm. Traditionally Red is used for “Trip Alarms”, Amber 
for “Pre-Alarms”, White for “Process Alarms” and Green for “Status”. To aid 
channel navigation within the software each alarm window on the graphical 
display can be set to match the colour of the physical annunciator window. A 
drop down menu allows the user to select any of the six colours listed below 
and once the “Confirm Setting” control button is pressed using a left mouse 
click the associated graphic will be updated. 
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Input Tab 

The following options are available under the “Input” Tab 
 

Contact Type 

A drop-down menu allows the user to assign the Contact Type for each 
Channel. In the example below a Channel is being configured to “Normally 
Open” (Close to Alarm). As an option each Channel can be set to Normally 
Closed (Open to Alarm) or to receive the Input via a Serial Link. 
 

 
 

Delay Timers 

Each channel is equipped with timers that allow the user to select:- 
 

Abnormal Delay (ms) 

This option will prevent the alarm from occurring unless it has been present 
for a pre-set period of time. 
 

Normal Delay (ms) 

This option will prevent the alarm from being Reset until the delay time has 
elapsed.  
 
In the example shown below the Alarm must be present for a minimum of 50 
ms before it is activated and must have returned to normal for the same 
period before it can be reset. 
 

 
 

Field Contact Voltage. 

Standard 725B Systems use 24VDC as a Field Contact Voltage.  
 
As an option 125VAC/DC, 48VAC/DC or 250VAC/DC can be used via an 
external source and each Channel should be set to match the associated 
input level. 



Series 725B Instruction Manual – Rev 5 
 

Page 109 of 169 

Contact Fault Monitoring 

If required the user can enable Contact Fault Reporting to indicate that the 
input device has deteriorated beyond set limits due to contact or wiring faults.  
 
To access this features the user must select the “View” Menu followed by 
“Advanced View” and the alarm trip fields shown below will be visible.  
 

 
 
The following limits apply to each setting 
 

• Alarm Trip Low Hysteresis (%) = 10% 

• Dwell Time (secs) = 256 seconds max 

• Alarm Trip High Hysteresis (%) = 90% 
 

LINE A

LIN
E B

100%

FC VOLTAGE

0%

DWELL PERIOD TIME IN SEC

ALARM TRIP

HIGH HYSTERYSIS

ALARM TRIP

LOW HYSTERYSIS

 
 
These settings allow the user to define the trip points of each digital input and 
therefore any degradation in field wring can be detected and a watchdog 
alarm can be generated. In the above example the Low trip is set to 30% and 
the high trip is set to 70% with a dwell time of 10 seconds. 
 
Once a channel goes into alarm the dwell period is used to measure how long 
the switching voltage is present. If the circuit is healthy the switching voltage 
is typically shown by LINE A.  If the circuit has a resistive value the switching 
voltage is typically shown by LINE B.  
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Relay Tab 

If the System is provided with Repeat Relays on a per Channel basis the user 
will be able to access the fields listed under the “Relay Tab”. Please Note: On 
systems supplied with Dual Repeat Relays per channel both Relays are 
automatically set to the same state, (Coil State and Relay function) 
 
If the field has been greyed out Repeat Relays have not been selected within 
the System set up software. 
 

Coil Status 

The Non-Alarm Coil State of each Relay can be set to Normally Energised or 
Normally De-Energised as required. In the example below a Channel is being 
set to Normally Energised. 
 

 
 

Relay Function 

The function of each Relay can be set to follow the Input, follow the Alarm 
Logic or follow the Display. In the example shown below a Channel is being 
set to follow the Input. 
 

 
 

Abnormal Delay 

Each Repeat Relay can be set to activate after a preset time period has 
elapsed. 
 
In the example shown below a Relay has been set to 100mS and therefore 
the Relay will not change state until this time has elapsed. 
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Normal Delay 

Each Repeat Relay can be prevented from changing state unless the change 
in state has occurred for a set time period. 
 
In the example shown below a Relay has been set to 50mS and therefore the 
Relay will not change state until this time has elapsed. 
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Alarm Sequences 

Within the alarm annunciator market a common standard has been adopted 
by all key manufacturers and end users with regards to operational 
sequences. These standards are used worldwide to define the visual 
indication, audible alarm and the action the operator must take to control the 
annunciator.  
 
The Instrument Society of America provide full details of each alarm sequence 
within ISA 18.1-1979 (R1992) and RTK are fully compliant with the stated 
sequences. The most common sequences are detailed within this section of 
the manual. 
 
To define a sequence the user can simply select any of the listed ISA 
sequences, as typically shown below. 
 
In this example channel 5 is being set to ISA M sequence. 
 

 
 
 
Pushbuttons  
Six pushbuttons are provided on the annunciator unit to allow the user to be 
able to control any of the available sequences which can be set on a per 
channel basis. 
 
Lamp Test – is used to test the LED assemblies by illuminating them in a 
steady state for as long as the pushbutton is pressed 
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Functional Test – is used to simulate an input on all channels and therefore 
all windows and horn circuits will operate in accordance with the selected ISA 
sequence and additional pushbuttons will need to be pressed to step through 
the alarm sequence to return the unit to its normal state 
 
Mute – is used to silence the audible alarm whilst allowing the associated 
alarm window to continue to operate in accordance with the selected ISA 
sequence 
 
Acknowledge – is used to silence the alarm and change the state of the 
associated alarm window in accordance with the selected ISA sequence 
 
Reset – is used to return the alarm to the normal off state once the Input has 
returned to the normal condition  
 
First Reset – is used to reset the flash sequence on the first alarm to occur 
within a defined group of alarms. Once first reset has been pressed the next 
alarm to occur within the group will flash at the first up alarm rate. 
 
Audible Alarms 
Each channel within the annunciator can be set to operate either of the two 
integral audible alarms or they can be assigned to common relays configured 
as horn relays as required. 
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Additional Features 
 
Automatic Reset 
Once a channel has been acknowledged and its input has returned to normal 
the alarm can be set to automatically reset without the operator having to 
press the reset pushbutton 
 
Non Latch Sequence – (No Lock In) 
Alarms can be set to non lock-in, which allows the alarm to automatically 
return to the non alarm state as soon as the signal input returns to normal 
 
Ringback Sequence 
Ringback sequence is used to inform the operator both visually and audibly 
that an alarm condition has cleared and the channel can be reset to its normal 
off state. When a contact returns to normal the associated window will flash at 
approx ½ the speed of a normal alarm and the audible will sound. This 
identifies the specific alarm and informs the operator that the alarm can be 
reset to its normal off state.  
 
First Up Sequences 
When monitoring devices with interlinked functions such as a turbine or 
compressor it is often important to know the specific alarm that occurred first, 
as it will invariably result in cascade of secondary alarms. This allows the 
operator to focus on the root cause of failure and therefore limits the 
downtime and associated costs. This is achieved by having the first-up alarm 
flashing in a different manner compared to the subsequent alarms. Four 
different first-up sequences are available F0, F1, F2 and F3 as detailed below 
and in the following sequence tables.  
 
F0 The standard mode adopted by RTK Instruments, which indicates the first-

up alarm by flashing at twice the rate of subsequent alarms.  
F1 In this mode subsequent alarms appear in the acknowledged state, hence 

they do not flash. The audible device does not operate when subsequent 
alarms occur, unless still operating from the first alarm. The acknowledge 
pushbutton will reset the first-up indication. 

F2 In this mode all subsequent alarms do not flash, they will however operate 
the audible device. The acknowledge pushbutton will reset the first-up 
indication. 

F3 In this mode initial alarms appear with an intermittent flash rate and 
subsequent alarms flash at a steady rate. On acknowledge subsequent 
alarms revert to the steady on state and only the first alarm continues to 
flash at a slower rate.  

 
Please note auto reset and non lock- in functions are not recommended when 
using first up sequences as the true sequence of events cannot be 
guaranteed. 

 
The most common sequences are detailed below:- 
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ISA A – Automatic Reset – Lock In 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL

OR NORMAL

ALARM

FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE

WHILE ABNORMAL

RETURN

 TO NORMAL

 TO 

ABNORMAL

ACKNOWLWDGE

WHILE NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL

OR NORMAL

SILENT

ON

ACKNOW

 
Sequence Features 
 

1. Acknowledge and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. The Audible device is silenced and the flashing stops when 

acknowledged. 
5. Automatic reset of acknowledged alarms when the process has 

returned to normal 
6. Operational test 
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ISA A-1-2 – Automatic Reset – Silence Pushbutton Interlock 
 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 

OR NORMAL

ALARM

FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

SILENCE

RETURN

 TO NORMAL

 TO 

ABNORMAL

ACKNOWLEDGE

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 

OR NORMAL

SILENT

FLASHING

SILENCE

ABNORMAL 

OR NORMAL
PROCESS

VISUAL

AUDIBLE

SEQUENCE

ON

SILENT

ACKNOW

 
 
 
Sequence Features 
 

1. Acknowledge, silence and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. Silence pushbutton must be pressed before acknowledge 
5. Silence stops the audible alarm only 
6. The flashing stops when acknowledged. 
7. Automatic reset of acknowledged alarms when the process has 

returned to normal 
8. Operational test 
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ISA A-4 – Automatic Reset – Non Lock In 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 

OR NORMAL

ALARM

FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE

WHILE ABNORMAL

RETURN

 TO NORMAL

 TO 

ABNORMAL

RETURN 

TO NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 

OR NORMAL

SILENT

ON

ACKNOW

 
Sequence Features 
 

1. Acknowledge, and test pushbuttons. 
2. Alarm audible device 
3. Non Lock In of momentary alarms 
4. The audible device is silenced and the flashing stops when 

acknowledged. 
5. Automatic reset of alarms when the process has returned to normal 

before or after acknowledge (Non Lock In) 
6. Operational test 
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ISA A-4-5 – Automatic Reset – No Flashing 

 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 

OR NORMAL

ALARM

ON

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE

WHILE ABNORMAL

RETURN

 TO NORMAL

 TO 
ABNORMAL

RETURN 

TO NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 

OR NORMAL

SILENT

ON

ACKNOW

 
 
 
Sequence Features 
 

1. Acknowledge, and test pushbuttons. 
2. Alarm audible device 
3. The visual alarm does not flash 
4. Non Lock In of momentary alarms 
5. The audible device is silenced when acknowledged. 
6. Automatic reset of acknowledged alarms when the process has 

returned to normal 
7. Operational test 
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ISA A-4-5-6 – Status  

 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 

OR NORMAL

ALARM

ON

SILENT

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL
RETURN

 TO NORMAL

 TO 

ABNORMAL

Sequence Features 
 

1. Test pushbutton. 
2. No alarm audible  
3. The visual alarm does not flash 
4. Non Lock In of momentary alarms 
5. Automatic reset of alarms when the process has returned to normal 

before or after acknowledge (Non Lock In) 
6. Operational test 
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Please Note:- 
 
The drop down menu within the configuration software allows the user to 
select ISA Sequence A-4-5-6 to obtain Status Only indication however the 
audible alarm circuit will need to be disabled separately due to the large 
number of horn groups available within the system.  
 
If the audible alarm sounds on a channel that has been set to ISA A-4-5-6 
please check that the alarm is not part of a group which has been assigned to 
operate as an audible in the group operations tab. 
 
In the example below Group 8 is being used as an audible group 
 
Group Tab 
 
This screen shot indicates that a channel / channels have been set to Group 8 
 

 
 
Group Operations Tab 
 
This screen shot indicates that Group 8 has been set to operate as an Audible 
alarm 
 

 
 
 
To prevent the audible sounding on a status window the user should select a 
single status alarm window or group of status alarm windows and uncheck the 
tick box associated with a Group being used as an Audible in the example 
above this would be Group 8  
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ISA A-5 – Automatic Reset – No Flash 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL

OR NORMAL

ALARM

ON

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE

WHILE ABNORMAL

RETURN

 TO NORMAL

 TO 

ABNORMAL

ACKNOWLWDGE

WHILE NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL

OR NORMAL

SILENT

ON

ACKNOW

 
Sequence Features 
 

1. Acknowledge and test pushbuttons. 
2. Alarm audible device 
3. The visual alarm does not flash 
4. Lock In of momentary alarms until acknowledged 
5. The Audible device is silenced when acknowledged. 
6. Automatic reset of acknowledged alarms when the process has 

returned to normal 
7. Operational test 
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ISA M – Manual Reset – Lock In 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL

OR NORMAL

ALARM

FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE

WHILE ABNORMAL

RESET

 WHILE NORMAL

 TO 

ABNORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL

OR NORMAL

SILENT

ON

ACKNOW.

 
Sequence Features 
 

1. Acknowledge, reset and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. The Audible device is silenced and the flashing visual alarm stops 

when acknowledged. 
5. Manual reset of acknowledged alarms when the process has returned 

to normal 
6. Operational test 
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ISA M-1-2 – Manual Reset – Silence Pushbutton Interlock 

 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 

OR NORMAL

ALARM

FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

SILENCE

RESET

WHILE NORMAL

 TO 

ABNORMAL

ACKNOWLEDGE

AUDIBLE

VISUAL

SEQUENCE

PROCESS
ABNORMAL 

OR NORMAL

SILENT

FLASHING

SILENCE

ABNORMAL 

OR NORMAL
PROCESS

VISUAL

AUDIBLE

SEQUENCE

ON

SILENT

ACKNOW

 
Sequence Features 
 

1. Acknowledge, reset and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary alarms until acknowledged 
4. Silence pushbutton must be pressed before acknowledge 
5. Silence stops the audible alarm only 
6. The flashing stops when acknowledged.  
7. Manual reset of acknowledged alarms when the process has returned 

to normal 
8. Operational test 
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ISA R – Ringback 

 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL 

OR NORMAL

ALARM

FAST FLASH

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS ABNORMAL 

SILENT

ON

ACKNOW

NORMALPROCESS

VISUAL

AUDIBLE

SEQUENCE

SLOW FLASH

PULSING

RINGBACK

ACK WHILE ABNORMAL

RETURN TO NORMAL

TO ABNORMALRESET

RETURN 

TO NORMAL
ACKNOW

WHILE NORMAL

 
 
 
Sequence Features 
 

1. Acknowledge, reset and test pushbuttons. 
2. Alarm audible device. (optional Ringback audible device) 
3. Lock In of momentary alarms until acknowledged 
4. The audible device is silenced and the flashing stops when 

acknowledged 
5. Ringback visual ad audible indications when the process condition 

returns to normal 
6. Manual reset of Ringback indications 
7. Operational test  
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ISA F1A-1 – Automatic Reset First Up 

PROCESS

SEQUENCE

VISUAL

AUDIBLE

ABNORMAL

OR NORMAL

FIRST ALARM

FLASHING

AUDIBLE

SEQUENCE

PROCESS

OFFVISUAL

AUDIBLE SILENT

NORMAL

NORMAL

ACKNOWLEDGE

WHILE ABNORMAL

(FIRST OUT RESET)

RETURN

 TO NORMAL

FIRST TO 

ABNORMAL

AUDIBLE

VISUAL

SEQUENCE

PROCESS ABNORMAL

SILENT

ON

ACKNOW.

SUBSEQUENT 

 TO ABNORMAL

 
Sequence Features 
 

1. Acknowledge and test pushbuttons. 
2. Alarm audible device 
3. Lock In of momentary first alarm only, no lock in of momentary 

subsequent alarms  
4. Flashing and audible indications for first alarm only, new subsequent 

alarms go to the acknowledge state. 
5. First out indication is reset and the audible is silenced when 

acknowledged. 
6. Automatic Reset of acknowledged alarm indications when the process 

returns to normal 
7. Silence pushbutton can be used to silence the audible alarm only 
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ISA F2M-1 – Manual Reset First Up 

 

 

PROCESS

AUDIBLE

VISUAL

SEQUENCE

ACKNOWLEDGE

VISUAL ON

FIRST ALARM

SEQUENCE ISA   F2M-1
(MANUAL RESET FIRST OUT WITH NO SUBSEQUENT ALARM FLASHING & SILENCED PUSHBUTTON)

AUDIBLE

ACKNOWLEDGE
(FIRST OUT RESET)

VISUAL

SEQEUNCE

PROCESS

SILENT

FLASHING

FIRST SILENCED SILENCE

ACKNOWLEDGE
(FIRST OUT RESET)

SILENT

ACKNOWLEDGED

ON

AUDIBLE

AUDIBLE

VISUAL

SEQUENCE

ON

PROCESS

AUDIBLE

FLASHING

ABNORMAL

SILENCE

PROCESS

SEQUENCE

RESET WHILE
NORMAL

AUDIBLE

VISUAL

PROCESS

SEQUENCE

SUBSEQUENT TO 

ABNORMAL

SUBSEQUENT
ALARM

SILENT

OFF

NORMAL

NORMAL

FIRST TO 
ABNORMAL

SEQUENCE DIAGRAM

OR NORMAL

ABNORMAL

OR NORMAL

ABNORMAL

OR NORMAL

ABNORMAL

OR NORMAL
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LINE 
PROCESS 

CONDITION 
PUSHBUTTON 
OPERATION 

SEQUENCE 
STATE 

VISUAL 
DISPLAY 

ALARM 
AUDIBLE 
DEVICE 

REMARKS 

1 NORMAL  NORMAL OFF SILENT  

2 FIRST ABNORMAL  FIRST ALARM FLASHING AUDIBLE LOCK-IN 

3 SUB. ABNORMAL  SUB. ALARM ON AUDIBLE LOCK-IN 

4 FIRST 
ABNORMAL OR 

NORMAL 
FIRST OUT 

RESET 

5 SUB. 
ABNORMAL OR 

NORMAL 

ACKNOWLEDGE 
BEFORE SIL 

TO LINE 7 

 

6 FIRST 
ABNORMAL OR 

NORMAL 
SILENCE FIRST SILENCED FLASHING SILENT  

7 SUB. 
ABNORMAL OR 

NORMAL 
SILENCE ACKNOWLEDGE ON SILENT 

MANUAL 
RESET 

REQUIRED 

8 FIRST 
ABNORMAL OR 

NORMAL 
ACKNOWLEDGE 
AFTER SILENCE 

TO LINE 7 
FIRST OUT 

RESET 

9 NORMAL RESET NORMAL OFF SILENT 
MANUAL 
RESET 

 
 

SEQUENCE FEATURES 
 

1. Silence, acknowledge, reset and test pushbuttons 
2. Alarm audible device 
3. Lock-in of momentary alarms until acknowledged.  
4. Option1 – silence pushbutton to silence the alarm audible 

device while retaining the first out flashing indication 
5. Flashing indication for first alarm only. new subsequent 

alarms have the same visual indication as acknowledged 
alarms. 

6. First out indication is reset when acknowledged 
7. Manual reset of acknowledged alarm indications after 

process conditions return to normal. 
8. Operational test 

 

ISA F2A-1 – Automatic Reset First Up 

This sequence is the same as ISA F2M-1 with the exception that the alarms 
are automatically reset once the process has returned to normal. 
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ISA F3A – Automatic Reset First Up 

 
 

 
 
 
 
 
 
 
 
 

AUDIBLE

PROCESS

VISUAL

SEQUENCE

SEQUENCE ISA   F3A
(AUTOMATIC RESET FIRST OUT WITHOUT FLASHING & RESET PUSHBUTTON)

FIRST OUT RESET

WHILE ABNORMAL

AUDIBLE

VISUAL

SEQUENCE

SILENT

PROCESS

ACKNOWLEDGE

SILENT

FIRST 

SLOW FLASHING

ABNORMAL

AUDIBLE AUDIBLE

INTERMITTENT

FLASHING

FIRST ALARM

FIRST OUT RESET

SUBSEQUENT

ACKNOWLEDGE

ON

ABNORMAL

VISUAL

AUDIBLE

PROCESS

STATE

SEQUENCE

VISUAL

PROCESS

FAST FLASHING

ON

SUBSEQUENT

ALARM

ABNORMAL

SEQUENCE DIAGRAM

RETURN 

TO NORMAL

ACKNOWLEDGE 
WHILE NORMAL

AUDIBLE

VISUAL

PROCESS

SEQUENCE FIRST TO 

ABNORMAL

SUBSEQUENT TO 
ABNORMAL

SILENT

OFF

NORMAL

NORMAL

ABNORMAL 

ACKOWLEDGED

OR NORMAL
FIRST OUT RESET

WHILE NORMAL

A
C

K
N

O
W

L
E

D
G

E
 

W
H

IL
E

 A
B

N
O

R
M

A
L

OR NORMAL

OR NORMAL
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SEQUENCE TABLE 

 

LINE 
PROCESS 

CONDITION 
PUSHBUTTON 
OPERATION 

SEQUENCE 
STATE 

VISUAL 
DISPLAY 

ALARM 
AUDIBLE 
DEVICE 

REMARKS 

1 NORMAL  NORMAL OFF SILENT  

2 FIRST ABNORMAL  FIRST ALARM 
INTERMITTENT 

FLASHING 
AUDIBLE LOCK-IN 

3 SUB. ABNORMAL  SUB. ALARM 
FAST 

FLASHING 
AUDIBLE LOCK-IN 

4 FIRST 
ABNORMAL 
OR NORMAL 

FIRST OUT 
RESET BEFORE 
ACKNOWLEDGE 

TO LINE 3 
FIRST OUT 

RESET 

5 FIRST 
ABNORMAL 
OR NORMAL 

FIRST 
ACKNOWLEDGED 

SLOW 
FLASHING 

SILENT 
FIRST OUT 

RESET 
REQUIRED 

6A SUB. ABNORMAL  
SUB. 

ACKNOWLEDGE 
ON SILENT 

MAINTAINED 
ALARM 

6B SUB. NORMAL 

ACKNOWLEDGE 

TO LINE 8 
MOMENTARY 

ALARM 

7A FIRST ABNORMAL TO LINE 6A 
FIRST OUT 

RESET 

7B FIRST NORMAL 

FIRST OUT 
RESET AFTER 

ACKNOWLEDGE TO LINE 8 
FIRST OUT 

RESET 

8 NORMAL  NORMAL OFF SILENT 
AUTOMATIC 

RESET 

 
 

SEQUENCE FEATURES 
 
1. Silence, acknowledge, reset and test pushbuttons 
2. Alarm audible device 
3. Lock-in of momentary alarms until acknowledged.  
4. Flashing indication for first alarm only. New subsequent alarms 

have the same visual indication as acknowledged alarms. 
5. First out indication is reset when acknowledged 
6. Manual reset of acknowledged alarm indications after process 

conditions return to normal. 
7. Operational test 



Series 725B Instruction Manual – Rev 5 
 

Page 130 of 169 

 
 

ISA F3A-3 – First Out Reset Interlock 

 
This sequence is the same as F3A with the addition of First Reset Interlock 
which requires acknowledge to be pressed before First Reset will function. 
 

ISA F3M – Manual Reset First Out  

 
This sequence is the same as F3A with the addition of Manual Reset. All 
alarms must be manually reset once the process has returned to normal.  
 

ISA F3M-1-2 – Manual Reset First Out with Silence Interlock 

 
This sequence is the same as F3A with the addition of Silence Interlock and 
Manual Reset.  
 
The Silence pushbutton must be operated before alarms can be 
acknowledged. The Silence pushbutton stops the Audible alarm only. 
 
All alarms must be manually reset once the process has returned to normal.  
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Pushbutton Groups 

 

Global Pushbutton Groups 

Pushbutton functions are available on 725B annunciators which can be used 
to Test or control the alarms in accordance with ISA S18.1 Alarm Sequences.  
 
In standard applications all channels are assigned to a single Pushbutton 
Group, (Group 1), however the user can enable or disable any of the functions 
on a per channel basis.   
 
In the example shown below the Silence Pushbutton has been disabled for 
Channel 1. 
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Multiple Pushbutton Groups 

In more complex applications each channel can be assigned to any of (8) 
Pushbutton Groups. 
 
To access the additional groups the user must select the “View” menu 
followed by “Advanced View”. This will allow the 8 Groups to be displayed as 
shown below.  
 
In the example below Lamp Test, Ack & Reset have been assigned to 
Pushbutton Group 2 for channels 9 to 14.  
 

 
 
Please Note:-  
Pushbutton Group 1 is assigned to the Internal Pushbutton Module and any 
additional Pushbutton Groups will require the use of external pushbuttons.  
 
On standard systems (3) Pushbutton Input terminals are available on the first 
alarm card in the system for use with remote pushbuttons. If more than (3) 
remote inputs are required adjacent cards are supplied with pushbutton 
inputs, (3 per card). 
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Alarm Groups 

Each channel within the annunciator can be linked to form part of a single or 
multiple Alarm Group (Group 1 to 8). Groups are typically used to provide 
summary alarm information that can be used by 3rd party devices (DCS / PLC 
/ SCADA / Supervisor Consoles). 
 
Channels can be assigned to a single or multiple Groups using a left “mouse” 
click on the associated field. In the example below a Channel has been 
assigned to Alarm Group 1 & 2.  
 

 
 
Additional Groups 
In more complex applications the user is able to access additional menus 
which allow any Channel within the Annunciator to be linked to a maximum of  
32 Groups 
 
To access the additional features the user must select the “View” menu 
followed by “Advanced View” to reveal the additional Groups as shown below.  
 

 
 
In the above example Channel 1 has been assigned to Group 1, 4 , 8 and 21. 
 
Once an Alarm Group has been defined the user can assign a single or 
multiple Relays to any of the Groups as detailed under the “WR1” Watchdog / 
Relay Tab Setting within this manual. 
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Horn Groups 

Each Channel within the annunciator can be linked to form part of a single or 
multiple Horn Groups. Horn Groups are typically used to provide different 
tones for critical and non-critical alarms, but they can also be used when 
alarms need to be repeated to 3rd Party devices and the signal needs to be 
reset once the local alarm has been acknowledged. 
 
Channels can be assigned to a single or multiple Groups using a left “mouse” 
click on the associated field. In the example below a Channel has been 
assigned to Group 1 & 2.  
 

 
 
Additional Horn Groups 
In more complex applications the user is able to access additional menus 
which allow any Channel within the Annunciator to be linked to a maximum of  
32 Horn Groups. 
 
To access the additional features the user must select the “View” menu 
followed by “Advanced View” to reveal the additional Horn Groups as shown 
below.  
 

 
 
In the example shown above Channel 6 has been assigned to Horn Group 1, 
3 & 5. Once a Horn Group has been defined the user can assign a single or 
multiple Relays to any of the Groups as detailed under the “WR1” Watchdog / 
Relay Tab Setting within this manual.  
 
Internal Horns:- Either of the 2 x Internal Horns can be set to operate from 
any Horn Group as required. 
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SECTION 15 - SPECIFICATIONS 

 
Logic power  

24VDC (19 – 28VDC) 
 
Power Supplies 
 

1. Integral power supplies  
Universal Input Type capable of accepting  
85 – 264VAC OR 
88 – 360VDC 

 
Each power supply can power up to 40 small windows, 20 medium 
windows or 10 large windows.  

 
2. Multiple integral power supplies  

In larger systems multiple integral power supplies can be used 
 

3. Remote power supplies 
RTK offer a complete range of remote mounting AC/DC OR DC/DC 
power supplies in various wattages to suit individual applications and 
separate data sheets are available for these units. 

 
Redundant power supplies  

In safety critical applications integral or remote power supplies can be 
supplied in redundancy allowing the system to operate from two power 
sources. 

 
Quiescent current  

Each channel requires 20mA in the non alarm state 
 
Alarm state current  

The following table details the current required per channel whilst in the 
alarm state.  

 
Window Size Small Medium Large 
Standard systems 40mA 60mA 100mA 
Systems with repeat relays 50mA 70mA 110mA 
Pushbutton  module, common relays & integral audibles 200mA 

 
Signal Inputs 

All inputs are provided with optical isolators capable of withstanding a 
1000 volts megger test to ground. 
The standard unit provides 24VDC as a signal supply voltage and 
options exist for 24VAC, 48V AC/DC, 125V AC/DC or 250V AC/DC. 

 
Input response time 

The user can select the response time required per channel in the 
range 1ms to 65S using the RTK supplied configuration software. 
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First-Up discrimination 

Better than 10mS  
 
Outputs 
 
Individual channel repeat relays 
As an option each channel within the Annunciator can be supplied with a 
dedicated repeat relay with SPDT contacts allowing the user to jumper select 
a N/C or N/O contact for use with 3rd Party devices. 
 
Contact rating  
 
Voltage Rating (resistive) 
24VDC 2A 
125VDC 0.5A 
125VAC 1A 

 
Common relays 
All units are provided with a minimum of four common relays which can be 
software configured for use as Group, Horn or Watchdog relays. Additional 
common relays can be supplied as optional extras. 
 
Contact rating  
 
Voltage Rating (resistive) 
24VDC 2A 
125VDC 0.5A 
125VAC 1A 
 
Audible alarms 
Two integrally mounted audible alarms are provided on systems using the 
integral pushbutton module. Each audible has a unique tone and the 
configuration software allows the user to adjust the volume and to pulse either 
audible as required. Common relays can be configured to operate as audible 
alarms as required. 
 
Communications 
Standard 725B units are provided with RS232 Modbus port with RTU or ASCII 
protocols. Optional protocols such as DNP3 are available 

Environmental Specifications 

Temperature 

Operating Temperature - 20 to + 60 Degrees C 
 

Storage Temperature    - 20 to + 80 Degrees C 
 

Humidity 0 – 95% RH, Non Condensing 
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Protection 
 

Annunciator front: IP41 
Annunciator rear: IP20 
Optional covers and Enclosures available for IP54 up to IP67 

 

Radiated RFI Immunity 

 IEC 61000-4-3 

Conducted RFI Immunity 

 IEC 61000-4-6 

Radiated Emissions 

 IEC 61000-6-3 

Conducted Emissions 

 IEC 61000-6-3 

Radiated Power Frequency Magnetic Field 

 IEC 61000-4-8 

ESD Effects  

 IEC 61000-4-2 

Dielectric Withstand 

 1500V RMS   

Surge Withstand – Oscillatory 

 ANSI C37.90.1 

Electrical Fast Transient/Burst Immunity 

 IEC 61000-4-4 

Surge Immunity 

 IEC 61000-4-5 

Approvals  

 
 



Series 725B Instruction Manual – Rev 5 
 

Page 138 of 169 

SECTION 16 - SPARE PARTS LIST 

Four Channel Alarm Cards  

24V / 125V Signal Input Versions  

 
Part No Description 
CB6611POP1 Standard alarm card 
CB6611POP3 Alarm card plus three remote pushbutton inputs 

CB6611POP5 Alarm card  plus sequential event recorder memory 
CB6611POP7 Alarm card with three remote pushbutton inputs and 

sequential event recorder memory 

24V / 125V Differential Input Versions  

 
Part No Description 
CB6611POP9 Alarm cards with differential inputs 
CB6611POP11 Alarm cards with differential inputs plus sequential event 

recorder memory 

48V / 250V Signal Input Versions   

 
Part No Description 
CB6611POP2 Standard alarm card 
CB6611POP4 Alarm card plus three remote pushbutton inputs 
CB6611POP6 Alarm card  plus sequential event recorder memory 
CB6611POP8 Alarm card with three remote pushbutton inputs and 

sequential event recorder memory 

48V / 250V Differential Input Versions 

 
Part No Description 
CB6611POP10 Alarm cards with differential inputs 
CB6611POP12 Alarm cards with differential inputs plus sequential event 

recorder memory 

Four Channel Repeat Relay Card 

 
Part No Description 
CB6613POP1 Four Channel Repeat Relay Card 
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Common Relay Card 

 
Part No Description 
CB6641POP1 Common Relay Card used in WR Cell on systems supplied 

with integral pushbutton modules 
CB6641POP2 Common Relay Card used in WR Cell on systems supplied 

with remote pushbutton modules 

 

White LED Assembly 

 
Part No Description 
CB7028POP1 “Fit & Forget” White LED Assembly 
 
Integral Power Supply 
 
Part No Description 
CB6617POP1 Integral Universal Input Power Supply Card 

 
Pushbutton Card 
 
Part No Description 
CB6678POP1 Pushbutton Assembly Spare Card 
 
SI/O Cards (Logic/Signal Power Input Cards) 
 
Part No Description 
CB6648POP1 Standard Power Input Card used with External PSU 
CB6648POP2 Standard Power Input Card used with Integral PSU 
CB6648POP3 Power Input Card used with External PSU c/w RS485 

Communications 

CB6648POP4 Power Input Card used with Integral PSU c/w RS485 
Communications 

SI/O Card (For use with remote Pushbutton Module) 

 
Part No Description 
CB6648POP5 Standard Power Input Card used with External Pushbutton 

Module version 

Ground Detector Card 

 
Part No Description 
CB7042POP Ground Fault Detector Card 
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USB Programming Cable 

 
Part No Description 
725B-USB USB Programming Cable 

Bezels 

 
Part No Description 
ML-7227-L Bezel for use with 60mm x 60mm Large Windows 
ML-7227-M Bezel for use with 60mm x 30mm Medium Windows 
ML-7227-S Bezel for use with 30mm x 30mm Small Windows 
 

Clear Lens 

 
Part No Description 
ML-7228-L Lens for use with 60mm x 60mm Large Windows 

ML-7228-M Lens for use with 60mm x 30mm Medium Windows 
ML-7228-S Lens for use with 30mm x 30mm Small Windows 

 

Spares Kits (External Power Supply Version) 

 
Part No Description 
CB7028POP1 White LED Assembly 
FU-1A-002 Signal Supply Fuse 5 x 20 mm 1A 
FU-8A-003 Logic Supply Fuse 5 x 20 mm 8A 

 

Spares Kits (Internal Power Supply Version) 

 
Part No Description 
CB7028POP1 White LED Assembly 
FU-1A-002 Signal Supply & 24VDC Output Fuse 5 x 20 mm 1A 
FU-2A-003 Primary Supply Fuse 5 x 20 mm 2A 
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SECTION 17 - SERVICING 

Module Removal 

 
All of the cards within the 725B are removable from the rear of the instrument 
 
To remove a card we recommend the following procedure:- 
 

A

INPUTS

1 2 3 4 3C2C1C 4C

CHANNEL

REAR VIEW

5 - 8

LOCKING 
SCREW

TERMINAL
BLOCK

LOCKING TABS

 
 
 

1. Isolate the power to the Annunciator. 
2. Undo the locking screws on either side of the terminal block on the 

rear of the cell. 
3. Unplug the terminal block, which can be removed with field wiring still 

attached. 
4. The plastic rear cover can be removed using a flat blade screwdriver 

to release the locking tabs on either side of the cover. 
5. Once the rear cover has been removed the associated card can be 

withdrawn by pulling on the socket. 
6. Please note each card in the system has its own unique address and it 

is important that the user notes the address if removing multiple cards 
or replacing a card. 

7. Once a card has been replaced the plastic cover can be clipped back 
into position, the terminal block can be re-connected and the screws 
tightened to lock it in place. 

 
IMPORTANT 

 
8. If a card has been replaced the user will need to download the original 

software configuration to the unit to ensure that the features of the new 
card match the original one. 
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Card Address Setting 

Before each card is placed within the annunciator a unique address number is 
set using the switches located on DIL switch SW1 as shown on a typical 
alarm card in the diagram below. 
 
 
 
 

7 85 62 3 41

SW1 DIL SWITCH

OFF

ON

4 6 8752 31

SW1

 
 
 
The first card in the system, top right hand corner when viewed from the rear, 
is factory set to Address 0 and the remaining cards require their own unique 
address for the system to operate correctly. The factory default regarding 
addressing varies according to window size. 
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Small Window versions. 
 
In the example shown 7 x four channel alarm cards plus 1 x common relay 
card would be fitted in the cell positions indicated below:  
 
 

WR

OV OV +V+V OVC +VC

Rx F1 F2 Tx

CR1 CR2 CR3 CR4

CHANNEL
AP

P1

EXT. PBINPUTS

2 31 4 C P3P2

1 - 4

2C

INPUTS

2 31 1C4 4C3C

A17 - 20

CHANNEL

1 2 4C1C43 3C2C

INPUTS

A
CHANNEL

9 - 12

1 2 4C1C43 3C2C

INPUTS

A
CHANNEL

25 - 28

321 4 1C 2C 3C 4C

INPUTS

A
CHANNEL

21 - 24

1 2 4C

INPUTS

1C43
3C

2C

CHANNEL

13 - 16 A

1

INPUTS

3 42 2C 3C1C 4C

5 - 8

CHANNEL
A

CELL 6 CELL 4 CELL 2 CELL 0

CELL 7 CELL 5 CELL 3 CELL 1

 

 
Card Cell Type Cell Address 

1 AP 0 0 

2 A 1 1 

3 A 2 2 

4 A 3 3 

5 A 4 4 

6 A 5 5 

7 A 6 6 

8 WR 7 7 

 
DIL switch SW1 on each card in the system should be set to match the Cell 
number as indicated in the diagram above which shows the rear view of a 
typical small window 725B Annunciator. 
 
For details on how to set the address please refer to the following page. 
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Medium Window versions. 
 
In the example shown 4 x four channel alarm cards plus 1 x common relay 
card would be fitted in the cell positions indicated below:  
 
 

WR

OV OV +V+V OVC +VC

Rx F1 F2 Tx

CR1 CR2 CR3 CR4

CHANNEL
AP

P1

EXT. PBINPUTS

2 31 4 C P3P2

1 - 4

2C

INPUTS

2 31 1C4 4C3C

A
CHANNEL

1 2 4C1C43 3C2C

INPUTS

A
CHANNEL

1 2 4C1C43 3C2C

INPUTS

A
CHANNEL

CELL 6 CELL 4 CELL 2 CELL 0

CELL 7 CELL 5 CELL 3 CELL 1

5 - 89 -1213 - 14

 
 

Card Cell Type Cell Address 

1 AP 0 0 

2 A 2 2 

3 A 4 4 

4 A 6 6 

5 WR 7 7 

 
DIL switch SW1 on each card in the system should be set to match the Cell 
number as indicated in the diagram above which shows the rear view of a 
typical medium window 725B Annunciator. 
 
For details on how to set the address please refer to the following page. 
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Large Window versions. 
 
In the example shown 2 x four channel alarm cards plus 1 x common relay 
card would be fitted in the cell positions indicated below:  
 
 

WR

OV OV +V+V OVC +VC

Rx F1 F2 Tx

CR1 CR2 CR3 CR4

CHANNEL
AP

P1

EXT. PBINPUTS

2 31 4 C P3P2

1 - 4

2C

INPUTS

2 31 1C4 4C3C

A9 -12

CHANNEL

CELL 6 CELL 4 CELL 2 CELL 0

CELL 7 CELL 5 CELL 3 CELL 1

 

 
Card Cell Type Cell Address 

1 AP 0 0 

2 A 4 4 

3 WR 7 7 

 
DIL switch SW1 on each card in the system should be set to match the Cell 
number as indicated in the diagram above which shows the rear view of a 
typical large window 725B Annunciator. 
 
For details on how to set the address please refer to the following page. 
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Typical Alarm Card DIL Switch SW1 Address Settings  

 

ADDRESS 128 64 32 16 8 4 2 1 

NO. BINARY SW1-8 SW1-7 SW1-6 SW1-5 SW1-4 SW1-3 SW1-2 SW1-1 

0 00000000 OFF OFF OFF OFF OFF OFF OFF OFF 

1 00000001 OFF OFF OFF OFF OFF OFF OFF ON 

2 00000010 OFF OFF OFF OFF OFF OFF ON OFF 

3 00000011 OFF OFF OFF OFF OFF OFF ON ON 

4 00000100 OFF OFF OFF OFF OFF ON OFF OFF 

5 00000101 OFF OFF OFF OFF OFF ON OFF ON 

6 00000110 OFF OFF OFF OFF OFF ON ON OFF 

7 00000111 OFF OFF OFF OFF OFF ON ON ON 

8 00001000 OFF OFF OFF OFF ON OFF OFF OFF 

9 00001001 OFF OFF OFF OFF ON OFF OFF ON 

10 00001010 OFF OFF OFF OFF ON OFF ON OFF 

11 00001011 OFF OFF OFF OFF ON OFF ON ON 

12 00001100 OFF OFF OFF OFF ON ON OFF OFF 

13 00001101 OFF OFF OFF OFF ON  ON OFF ON 

14 00001110 OFF OFF OFF OFF ON ON ON OFF 

15 00001111 OFF OFF OFF OFF ON ON ON ON 

16 00010000 OFF OFF OFF ON OFF OFF OFF OFF 

17 00010001 OFF OFF OFF ON OFF OFF OFF ON 

18 00010010 OFF OFF OFF ON OFF OFF ON OFF 

19 00010011 OFF OFF OFF ON OFF OFF ON ON 

20 00010100 OFF OFF OFF ON OFF ON OFF OFF 

21 00010101 OFF OFF OFF ON OFF ON OFF ON 

22 00010110 OFF OFF OFF ON OFF ON ON OFF 

23 00010111 OFF OFF OFF ON OFF ON ON ON 

24 00011000 OFF OFF OFF ON ON OFF OFF OFF 

25 00011001 OFF OFF OFF ON ON OFF OFF ON 

26 00011010 OFF OFF OFF ON ON OFF ON OFF 

27 00011011 OFF OFF OFF ON ON OFF ON ON 

28 00011100 OFF OFF OFF ON ON ON OFF OFF 

29 00011101 OFF OFF OFF ON ON ON OFF ON 

30 00011110 OFF OFF OFF ON ON ON ON OFF 

31 00011111 OFF OFF OFF ON ON ON ON ON 

32 00100000 OFF OFF ON OFF OFF OFF OFF OFF 

33 00100001 OFF OFF ON OFF OFF OFF OFF ON 

34 00100010 OFF OFF ON OFF OFF OFF ON OFF 

35 00100011 OFF OFF ON OFF OFF OFF ON ON 

36 00100100 OFF OFF ON OFF OFF ON OFF OFF 

37 00100101 OFF OFF ON OFF OFF ON OFF ON 

38 00100110 OFF OFF ON OFF OFF ON ON OFF 

39 00100111 OFF OFF ON OFF OFF ON ON ON 

40 00101000 OFF OFF ON OFF ON OFF OFF OFF 

 
Address 0 To 40 are shown for reference  
 
A max of 64 addresses are available = 64 x 4 channels per card = 256 
channels max in a single annunciator.  
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SECTION 18 – CONTACT 

RTK Instruments Limited 
St James Business Park 
Knaresborough 
North Yorkshire 
HG5 8PJ 
 
Telephone / Fax Number List 
 
Telephone: 0044 (0) 1423 580500 
           Fax: 0044 (0) 1423 580501 
 

Procedures for Factory Repair and Return Warranty 

 
Please refer to the RMA Form on the following page which we request is 
copied to allow the user to complete the details to request a Returns Materials 
Authorisation Number. 
 
Once the form has been received by RTK an RMA number will be advised 
and we request that this number is used on any corresponding paperwork / 
packing lists. 
 
RTK kindly request that all goods are adequately packed and note that we 
cannot be held responsible for any transit damage caused by inadequate 
packing. 
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RMA FORM 

  RTK Instruments Limited 
 

  St James Business Park, 
 

  Knaresborough, North Yorkshire, 
 

  England. HG5 8PJ 

 

Telephone: +44 (0)1423 580500 
 

 Facsimile:   +44 (0)1423 580501 
 

 Web: www.rtkinstruments.com 
 

 Email: enquiry@ rtkinstruments.com 
 

 

 

Advance Replacement Tracking No RMA**** 
 

To request advance replacements for parts that have been reported faulty during the warranty period 
please complete the details below. 

 
Customer  

 

Address  
 

Contact  

Telephone No  

Fax No  
 

Items to be Returned 
  

Qty Part No. Serial No. Reported Fault 

    

    

    

    

Note: If the replacement item is different this will be shown on the related 
sales Order 
 

RTK Commitment 
As part of the ongoing service and support to our customers we agree to supply Advance 
Replacements on the basis that our instruments are used as a critical part of plant control and 
instrumentation and also in many safety critical applications.   

 

Agreement from the client 
As part of the agreement to supply parts as Advance Replacements we also need certain limited 
commitments from the customer as follows: - 
 
1. The original parts shall be returned, within 30 days of despatch of the advance replacements, 

to allow our QA / Test department to investigate the reason of failure.  If the goods are not 
received within this period then the user agrees to pay for the advance replacements (and 
related carriage) in full. 

2. If the failure is found to be caused by RTK workmanship or component failure there will be no 
charge incurred for the materials or the ongoing carriage. 

3. If the returned goods are found to have been damaged by incorrect operation or misuse a 
charge will be incurred to cover the costs of repair, recalibration and carriage costs. 

4. If the returned goods are found to have no faults the user agrees to pay a handling, 
inspection, re-test and carriage charge. 

 
Customer Authorisation Signature:- ……………………….. 
                                                 Name:- ………………………. 

FAX Back to +44 (0)1423 580501 

 



Series 725B Instruction Manual – Rev 5 
 

Page 149 of 169 

SECTION 19 - FACTORY DEFAULT SETTINGS 

 

Global Systems Setting Default Settings 

 
General Tab Default Settings 
 

 
 
Event Recording Tab Default Settings 
 

 
 
WR1 Tab Default Settings 
 

 
 
Local Pushbuttons Tab Default Settings 
 

 
 
Remote Pushbuttons Tab Default Settings 
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Internal Horn Tab Default Settings 
 

 
 
Auto Ack Tab Default Settings 
 

 
 
Auto Silence Tab Default Settings 
 

 
 
Group Operations Tab Default Settings 
 

 
 
Comm’s Tab Default Settings 
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Restore System Settings To Default 
This software provides the user with a host of customer selectable options.  
 
As users are able to select any number of features whilst navigating through 
the software they are able to return the software to factory default settings 
using the “Tools” and “Restore System Settings to Default” menu as shown 
below. 
 
 

 
 
CAUTION 
This setting will automatically convert the Systems Setting to factory default 
and therefore it should only be used with caution. 
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Individual Channel Default Settings 
 
Channel Tab Default Settings 
 

 
 
Input Tab Default Settings 
 

 
 
Relay Tab Default Settings 
 

 
 
Sequence Tab Default Settings 
 

 
 
Pushbutton Group Tab Default Settings 
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Groups Tab Default Settings 
 

 
 
Restore Selected Channel to Default 
This software provides the user with a host of customer selectable options.  
 
As users are able to select any number of features whilst navigating through 
the software they are able to return the software to factory default settings 
using the “Tools” and “Restore Selective Channels to Default” menu as shown 
below. 
  

 
 
CAUTION 
This setting will automatically convert the selected channel to factory default 
settings and therefore it should only be used with caution. 
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SECTION 20 – COMMUNICATIONS OPTIONS 

Standard Versions 

 
The 725B is available with Modbus Communication and the standard version 
is detailed below 
 
Communications Addresses 
Each card in the system requires a unique address therefore the first card in 
any given system is address 1, the second card address 2 etc. 
 
Modbus RTU 
The standard protocol used on the entry level communication option is 
Modbus RTU and this must be set in software as detailed in Section 13 under 
the comm’s tab settings. 
 
Modbus Function 1 is used to Read the state of the Inputs and Modbus 
Function 15 is used to Write to each Input. 
 
Alarm Management Software (AMS) 
When used with the optional RTK Alarm Management System the user needs 
to set the protocol to RTK-AMS Protocol in the drop down menu for 
communication to be established between the 725B and the associated PC 
based AMS software. 
 
Communication Speed  
The user is able to select the speed to communicate to 3rd party devices using 
the drop menu within the configuration software as detailed in Section 13 
under the com’s tab. This can be 38,400, 19,200 or 9,600 Baud as required. 
 
Connection Details 
An Industry standard RJ11 connector is provided on the XS/FC485 
communication card which allows the following connections:- 
 

PG4

123456

 
 
 

1. TXa 
2. No Connection 
3. OV 
4. RXb 
5. TXb 
6. RXa 
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Typical Connections 
 
725B 
 

Rxa

Rxb

Txa

Txb

2 WIRE

 
 
 
725B 
 

Rxa

Rxb

Txa

Txb

4 WIRE

 



Series 725B Instruction Manual – Rev 5 
 

Page 156 of 169 

MODBUS DATA 
 
RTU Tables 
Each character represents 8 bit binary data in a hexadecimal format. 
“Y” in the table represents a character that can have more than one value. 
All characters are framed with start bit, 1 parity bit and 1 stop bit. Some values 
are pre-defined and are shown in hex format. 
 
Read Status – Function 01 – Master 
 

START ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

ERROR 
CHECK 

STOP 

Elapsed 
Time 3 ½ 
Characters 
Min 

YY “01” YY YY YY 

Elapsed 
Time 3 ½ 
Characters 
Min 

 
Address 
Communication address of each alarm card in the system. The first card in 
the system is address 1 and the following cards are consecutively numbered. 
 
Function  
Modbus Function No 
 
Register Address 
This register is used to address the “start” channel input to be read For 
example the first channel in the system “channel 1” would be register address 
00 00 
 
Number of Registers 
This represents the number of coils, (Inputs), the user wishes to read 
 
Error Check 
This defines the error checking format required for example CRC (Cyclic 
Redundancy Check) 
 
Typical Example of Message Format 
To read all of the inputs available on the first alarm card in the system the 
user would need to read 4 digital and 3 remote pushbutton inputs using the 
following message format 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

ERROR 
CHECK 

01 01 00 00 00 07 7D C8 

 
To read channel two on the second alarm card in the system you would need 
the following message format 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

ERROR 
CHECK 

02 01 00 01 00 01 AC 39 
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To read all four channels on the fourth alarm card in the system you would 
need the following message format 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

ERROR 
CHECK 

04 01 00 00 00 04 3D 9C 

 
Read Status – Function 01 – Response 
 

START ADDRESS FUNCTION 
BYTE  

COUNT 
DATA 

ERROR 
CHECK 

STOP 

Elapsed Time 
3 ½ 
Characters 
Min 

Y “01” “01” Y YY 

Elapsed Time 
3 ½ 
Characters 
Min 

 
Address 
Communication address of each alarm card in the system. The first card in 
the system is address 1 and the following cards are consecutively numbered. 
 
Function  
Modbus Function No 
 
Byte Count 
This represents the number of bytes sent and will always be set to 1 as the 
maximum number of inputs per alarm card cannot exceed 7 (4 digital inputs 
plus 3 remote pushbutton inputs) 
 
Data 
This represents the input status of the requested inputs 
 
Error Check 
This defines the error checking format required for example CRC (Cyclic 
Redundancy Check) 
 
 
Write Status – Function 15  
 

START ADDRESS FUNCTION 
REGISTER 
ADDRESS 

QUANTITY 
BYTE 

COUNT 
DATA 

ERROR 
CHECK 

STOP 

Elapsed 
Time 3 ½ 
Characters 
Min 

Y “0F” YY YY “01” Y YY 

Elapsed 
Time 3 ½ 
Characters 
Min 

 
Address 
Communication address of each alarm card in the system. The first card in 
the system is address 1 and the following cards are consecutively numbered. 
 
Function  
Modbus Function No  
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Register Address 
This register is used to address the “start” channel input to be read For 
example the first channel in the system “channel 1” would be register address 
00 00 
 
Quantity 
This represents the number of coils, (Inputs), the user wishes to write to 
 
Byte Count 
This represents the number of bytes sent and will always be set to 1 as the 
maximum number of inputs per alarm card cannot exceed 7 (4 digital inputs 
plus 3 remote pushbutton inputs) 
 
Data 
This represents the input status of the inputs to be written 
 
Error Check 
This defines the error checking format required, and in the case of the 725B 
this should be set to CRC (Cyclic Redundancy Check) 
 
Typical Example of Message Format 
To write to all of the inputs available on the first alarm card in the system the 
user would need to send the following message 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

01 0F 00 00 00 04 01 0F 7E 92 

 
To write input 3 to the abnormal state on the second alarm card in the system 
you would need to send the following message 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

02 0F 00 02 00 01 01 01 D6 82 

 
To write input 3 to the normal state on the second alarm card in the system 
you would need to send the following message 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

02 0F 00 02 00 01 01 00 17 42 

 
To write channel 1 to the abnormal state and channels 2, 3 & 4 to the normal 
state on alarm card 4 you would need to send the following message 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

01 0F 00 00 00 04 01 01 FF 56 

 
To write the third pushbutton input on alarm card 1 to abnormal you would 
need to send the following message 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

01 0F 00 06 00 01 01 01 67 57 
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To write the third pushbutton input on alarm card 1 to normal you would need 
to send the following message 
 

ADDRESS FUNCTION 
REGISTER 
ADDRESS 

No Of 
REGISTERS 

BYTE 
COUNT 

DATA 
ERROR 
CHECK 

01 0F 00 06 00 01 01 00 A6 97 

 
 
Write Request – Function 15 – Response 
 

START ADDRESS FUNCTION 
REGISTER 
ADDRESS 

QUANTITY 
ERROR 
CHECK 

STOP 

Elapsed Time 
3 ½ 
Characters 
Min 

Y “OF” YYYY YY YY 

Elapsed Time 
3 ½ 
Characters 
Min 

 
Address 
Communication address of each alarm card in the system. The first card in 
the system is address 1 and the following cards are consecutively numbered. 
 
Function  
Modbus Function No 
 
Register Address 
This register is used to address the “start” channel input to be written: For 
example the first channel in the system “channel 1” would be register address 
00 00 
 
Quantity 
This represents the number of coils, (Inputs), the user wishes to write to 
 
Error Check 
This defines the error checking format required for example CRC (Cyclic 
Redundancy Check) 
 
Register Addresses 
The register addresses field contains the address of data within the 725B 
Slave. Address 4-6 are only valid on 4 channel alarm cards equipped with the 
optional 3 remote pushbutton inputs. 
 
REGISTER ADDRESS CHANNEL NUMBER 

0 1 
1 2 
2 3 
3 4 
4 PB1 

5 PB2 
6 PB3 

 
 
 



Series 725B Instruction Manual – Rev 5 
 

Page 160 of 169 

Input State 
 
0 = Normal 
 
1 = Abnormal 
 
If the input contact is abnormal this bit = 1 
 
If the input contact is normal this bit = 0 
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Versions fitted with Time Stamping & Modbus Protocol 

 
This section refers to 725B annunciators which have the time stamping option fitted 
(Option “T” in the Model No).  
 
Please note:- The type of events to be captured and the time stamping feature can 
be  enabled / disabled in software. The following examples are provided for 
reference:- 
 

 
 
Under the event recording tab the system has been set to provide event recording for 
Inputs events. 
 

  
 
Under the channel tab the user can enable each channel that requires Event 
Recording by selecting the check box as typically shown for channel 1 above 
 

 
The following pages provide details of the structure and responses for the available 
events between the communications card and a local PC. 
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Request Contact Status (PC to Alarm/Communications card) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63 

Comms option:- 
Entry level = Alarm card 
address 
Otherwise = Comms card 
address  

Function 0x03 1 Message type  
Start Address 0x9C41 2 

 
Internal address(40001) of 
word length register holding 
the number of events 
pending 

Number of registers 0xXXXX 2 Number of channels 
(Limited to 7 on Alarm/ PB 
card and 4 on Alarm card 
on entry level version) 

Checksum 0xXXXX 2 CRC error check 

 
Response to Contact Status Request (Alarm/Communications card to PC) 
 
Item Data Bytes Description  
Node Address 0xXX 1 Same as node address 

received in request 
message 

 

Function 0x03 1 Same as function 
received in request 
message 

 

Byte Count 0x0X 1 Number bytes of data 
(2 x Number channels 
requested) 

 

Contact Event 
Type Channel X 

0xXXXX 2 Event Type of channel 
Range (0 to 1) 

Repeated 
for each 
channel 
requested 

Checksum 0xXXXX 2 CRC error check  
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Request Alarm Status (PC to Alarm/Communications card) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63 

Comms option:- 
Entry level = Alarm card 
address 
Otherwise = Comms card 
address  

Function 0x03 1 Message type  
Start Address 0xA411 2 

 
Internal address(42001) of 
word length register holding 
the number of events 
pending 

Number of registers 0xXXXX 2 Number of channels 
(Limited to 7 on Alarm/ PB 
card and 4 on Alarm card 
on entry level version) 

Checksum 0xXXXX 2 CRC error check 
 

 
Response to Alarm Status Request (Alarm/Communications card to PC) 
 
Item Data Bytes Description  
Node Address 0xXX 1 Same as node address 

received in request 
message 

 

Function 0x03 1 Same as function 
received in request 
message 

 

Byte Count 0x0x 1 Number bytes of data 
(2 x Number channels 
requested) 

 

Alarm Event Type 
Channel X 

0xXXXX 2 Event Type of channel  
Range (64 to127) 

Repeated 
for each 
channel 
requested 

Checksum 0xXXXX 2 CRC error check  
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Request Disable Status (PC to Alarm/Communications card) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63 

Comms option:- 
Entry level = Alarm card 
address 
Otherwise = Comms card 
address  

Function 0x03 1 Message type  
Start Address 0xABE1 2 

 
Internal address(44001) of 
word length register holding 
the number of events 
pending 

Number of registers 0xXXXX 2 Number of channels 
(Limited to 7 on Alarm/ PB 
card and 4 on Alarm card 
on entry level version) 

Checksum 0xXXXX 2 CRC error check 

 
Response to Disable Status Request (Alarm/ Communications card to PC) 
 
Item Data Bytes Description  
Node Address 0xXX 1 Same as node address 

received in request 
message 

 

Function 0x03 1 Same as function 
received in request 
message 

 

Byte Count 0x0x 1 Number bytes of data 
(2 x Number channels 
requested) 

 

Disable Event 
Type Channel X 

0xXXXX 2 Event Type of channel  
Range (2 to 5) and (7 to 
8) 

Repeated 
for each 
channel 
requested 

Checksum 0xXXXX 2 CRC error check  
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 Request Number of Events Available (PC to Alarm/ Communications card) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63 

Comms option:- 
Entry level = Alarm card 
address 
Otherwise = Comms card 
address  

Function 0x03 1 Message type  
Start Address 0xC15A 2 

 
Internal address(49498) of 
word length register holding 
the number of events 
pending 

Number of registers 0x0001 2  
Checksum 0xXXXX 2 CRC error check 

 

 
Response to Number of Events Available Request (Alarm/ Communications 
card to PC) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Same as node address 

received in request 
message 

Function 0x03 1 Same as function received 
in request message 

Byte Count 0x02 1 Number bytes of data  
Number of events 0xXXXX 2 Number of events pending. 

Range 0 to 20 
Note: Not necessarily the 
same as total number of 
events stored  

Checksum 0xXXXX 2 CRC error check 
 

 



Series 725B Instruction Manual – Rev 5 
 

Page 166 of 169 

Request Event Data (PC to Alarm/ Communications card) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63. 

Comms option:- 
Entry level = Alarm card 
address 
Otherwise = Comms card 
address  

Function 0x03 1 Message type  
Start Address 0xC15B 2 

 
Internal address (49499) 
for pending events 

Number of registers 0x00XX 2 Number of event registers 
requested. (Number 
Events*Number registers 
per event) 
Number registers per event 
= 6 
Events requested =< 
Number of pending events. 

Checksum 0xXXXX 2 CRC error check 
 

Response to Event Data Request (Alarm/ Communications card to PC) 
 
Item Data Bytes Description  
Node Address 0xXX 1 Same as node address 

received in request 
message 

 

Function 0x03 1 Same as function 
received in request 
message 

 

Byte Count 0xXX 1 Number bytes of data. 
Number = 6 * Num 
events requested.  

 

Card address 0xXX 2 Card address. 
Range 0 to 254 
NOTE: When Entry level 
comms is used this is 
defaulted to zero. 

Card Point 0xXX 2 Card Point. 
Range 0 to 3 

Event type 0xXX 2 Event type. 
Range 0 to 255 

Time sec 0xXXXXXXXX 4 Time sec 
Seconds Since 1970 

Time msec 0xXXXX 2 Time msec 
Milliseconds 

 
I 

Repeated 
Data 

Packet 
For 

Each 
Event 
Reqst 

I 

Checksum 0xXXXX 2 CRC error check  
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Input Event Type List 
 

Event Type Event Description 

0 Input return to normal 
1 Input Event activated  
2 Shelved  
3 Disabled 
4 Unshelved 
5 Enabled 
6 Configuration changed 
7 Inhibited 
8 Uninhibited  
9 Lamp Test Pushbutton activated 
10 Lamp Test PB return to normal 
11 Acknowledge Pushbutton activated 
12 Acknowledge PB return to normal  
13 Reset Pushbutton activated 
14 Reset PB return to normal 
15 Silence Pushbutton activated 
16 Silence PB return to normal 
17 System Test Pushbutton activated 
18 System Test PB return to normal 
19 First up and Acknowledge Pushbutton activated 
20 First up and Acknowledge PB return to normal 
21 Lamp Test and Audible Pushbutton activated 
22 Lamp Test and Audible PB return to normal 

23 Sleep Pushbutton activated 
24 Sleep Pushbutton return to normal 
25,27,29,31,33,35,37
,39. 

Pushbutton Group 1,2,3,4,5,6,7,8 activated 

26,28,30,32,34,36,38
,40. 

Pushbutton Group 1,2,3,4,5,6,7,8 return to normal 

41 Input Fault activated  
42 Input Fault normal  
43 Reserved 

44 Reserved 
45 Reserved 
46 Reserved 
47 Reserved 
48 Fram Fault  
49 LED Fault activated  

50 LED fault Normal 
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Output  Event Type List 
 

Event Type Event Description 
64 Alarm Event return to normal 
65 Subsequent Alarm Event activated 
66 First-up Alarm Event activated 
67 Subsequent Alarm Event Acknowledged 
68 First-up Alarm Event Acknowledged 
69 Alarm Event Ring-back 
 

 

Acknowledge Event Data (PC to Alarm/ Communications Card) 
 
Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63 

Comms option:- 
Entry level = Alarm card address 
Otherwise = Comms card address  

Function 0x06 1 Message type  
Start Address 0xC159 2 Internal address (49497) of events 

acknowledge register 
Register Data 0x00XX 2 Must equal the number of events 

originally requested in-order to 
successfully clear the pending 
events register. 

Checksum 0xXXXX 2 CRC error check 
 

 
Response to Acknowledge Event Data (Alarm/ Communications card to PC) 
 

Item Data Bytes Description 
Node Address 0xXX 1 Range 0 to 63 

Comms option:- 
Entry level = Alarm card address 
Otherwise = Comms card address  

Function 0x06 1 Message type  
Start Address 0xC159 2 Internal address (49497) of events 

acknowledge register 
Register Data 0x00XX 2 Data must equal same value as the 

original query 
Checksum 0xXXXX 2 CRC error check 
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Global Time Sync (PC to Interface Card) 
 
Item Data Bytes Description 
Node Address 0xFF 1 Global Address 255  
Function 0x10 1 Message type 
Start Address 0xC157 2 First internal address (49495) of 

Global Time Data 

Quantity 0x0002 2 Number of data registers to be sent 
Byte Count 0x04 1 Number of bytes of data to follow 
Data 0xXXXXXXXX 4 Time Seconds Since 1970 
Checksum 0xXXXX 2 CRC error check 
 
Note: No response is required for this message.  
 
 
 


